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1 Main Index

  Orca Help Index

  Getting Started

  Orca Remote

  Channel Guide

An Introduction To CQuat Fractals by Terry W. Gintz

Tutorial On Juliat Fractals by Terry W. Gintz

  Commands
File menu

Edit menu

Image menu

Type menu

Render menu

Pixel menu

View menu

Window menu

Video menu

Demo menu

Help menu

1.1 Title Bar

Title Bar

The title bar is located along the top of a window.  It contains the name of the application and
drawing.

To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging
their title bars.

A title bar may contain the following elements:
Application Control-menu button
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Drawing Control-menu button
Maximize button
Minimize button
Name of the application
Name of the drawing
Restore button

1.2 Scroll Bars

 Scroll bars

Displayed at the right and bottom edges of the drawing window.  The scroll boxes inside the
scroll bars indicate your vertical and horizontal location in the drawing.  You can use the
mouse to scroll to other parts of the drawing.

1.3 Size (system) command

Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer

to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.

1.4 Minimize (system) command

Minimize command (application Control menu)

Use this command to reduce the Orca window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9
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1.5 Maximize (system) command

Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a drawing window.

1.6 Move (system) command

Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or
dialog box with the arrow keys.

Note:  This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7

1.7 Restore (system) command

Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximize or Minimize command.

1.8 Close (system) command

Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a drawing window

ALT+F4 closes the application
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1.9 Previous Window (system) command

Previous Window command (drawing Control menu)

Use this command to switch to the previous open drawing window.  Orca determines which
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6

1.10 Next Window (system) command

Next Window command (drawing Control menu)

Use this command to switch to the next open drawing window.  Orca determines which
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6

1.11 Switch to (system) command

Switch to command (application Control menu)

Use this command to display a list of all open applications.  Use this "Task List" to switch to
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.  This option
does not affect applications reduced to icons.
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Tile
Arranges open applications into windows that do not overlap.  This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.

1.12 An Introduction To CQuat Fractals

  An Introduction To CQuat Fractals By Terry W. Gintz

In the process of exploring all possible extensions to a fractal generator of this type, I
considered using discrete modifications of the standard quaternion algebra to discover new
and exciting images.  The author of Fractal Ecstasy [6] produced variations of the
Mandelbrot set by altering the discrete complex algebra of z²+c.  The extension of this to
quad algebra was intriguing.  There was also the possibility of different forms of quad algebra
besides quaternion or hypercomplex types.

Having modeled 3D fractals with complexified octonion algebra, as described in Charles
Muses' non-distributive algebra [7], it was natural to speculate on what shapes a
"complexified" quaternion algebra would produce.  Would it be something that was between
the images produced with hypercomplex and quaternion algebra?  Quaternion shapes tend to
be composed of mainly rounded lines, and hypercomplex shapes are mainly square (see
Figures 1 and 2.)

Figure 1.  Quaternion Julia set of -1+0i

Figure 2.  Hypercomplex Julia set of -1+0i
For those not familiar with the basics of hypercomplex and quaternion algebra, here are the
algebraic rules that define how complex components interact with each other:

i j k
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i -1 k -j

j k -1 -i

k -j -i 1
Table 1 Hypercomplex variable multiplication rules

i j k

i -1 k -j

j -k -1 i

k j -i -1
Table 2 Quaternion variable multiplication rules

In both quaternion and hypercomplex algebra, i²=-1.  The hypercomplex rules provide for one
real variable, two complex variables, (i and j) and one variable that Charles Muses refers to as
countercomplex (k), since k*k = 1.  It would appear from this that k = 1, but the rules in Table
1 show that k has complex characteristics.  In quaternion algebra there is one real variable
and three complex variables.  In hypercomplex algebra, unlike quaternion algebra, the
commutative law holds; that is, reversing the order of multiplication doesn't change the
product.  The basics of quaternion and hypercomplex algebra are covered in Appendix B of
Fractal Creations [8].  One other concept important to non-distributive algebra is the idea of
a "ring".  There is one ring in quaternion and hypercomplex algebra (i,j,k). (There are seven
rings in octonion algebra.)  If you start anywhere in this ring and proceed to multiply three
variables in a loop, backwards or forwards, you get the same number, 1 for hypercomplex,
and 1 or -1 for quaternion, depending on the direction you follow on the ring.  The latter
emphasizes the non-commutative nature of quaternions.  E.g. : using quaternion rules, i*j*k =
k*k = -1, but k*j*i = -i*i = 1.

For "complexified" quaternion algebra, the following rules were conceived:

i j k

i -1 -k -j

j -k 1 i

k -j i 1
Table 3 CQuat variable multiplication rules

Note that there are two countercomplex variables here, (j and k).  The commutative law holds
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like in hypercomplex algebra, and the "ring" equals -1 in either direction.  Multiplying two
identical quad numbers together, (x+yi+zj+wk)(x+yi+zj+wk) according to the rules of the
complexified multiplication table, combining terms and adding the complex constant, the
following iterative formula was derived for the "complexified" quaternion set, q²+c:

x -> x*x - y*y + z*z + w*w + cx
y  -> 2.0*x*y + 2.0*w*z + cy
z -> 2.0*x*z - 2.0*w*y + cz
w -> 2.0*x*w - 2.0*y*z + cw

Just to get a feel for this new formula, a fairly basic constant, -1+0i, was used for the initial
3D test.  The extraordinary picture "Equilibrium"(Figure 3) was the result.

Figure 3.  Equilibrium -- cquat Julia rendering of -1+0i
Being familiar with the quaternion and hypercomplex renditions of the Julia set -1+0i, it
appeared that this image was a leap into hyperspace; the fractal seemed to literally expand in
all directions at once.  The next test used a Siegel disk constant, -.39054-.58679i, which
Roger Bagula [9] had recently sent.  The Siegel image (Figure 4) strongly suggested that
cquats were indeed a new form of space-filling fractal.

Figure 4  Siegel -- cquat Julia rendering of -.39054-.58679i

Since then, Godwin Vickers has ported the cquat formula to the Persistence of Vision Ray-
tracer [10], and verified that the equilibrium image wasn't just an artifact of Orca.  Nearly
identical images have been obtained in POV, using Pascal Massimino's [11] custom formula
algorithm for 3D Mandelbrot and Julia sets.

There remains the extension of cquat algebra to transcendental and exponential functions.
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Any ideas for this are welcome.  The built-in formulas in Orca have been revised to include
cquat variations where possible.

References
1. Hamilton, W. R. (1969) Elements of Quaternions, Vol. I and II, reprinted by Chelsea
Publishing Co.: New York
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1.13 Tutorial On Juliat Fractals

It is easy to speculate on what a true 3D representation of a 2D Julia set based on the complex
constant -1+0i would look like, but thus far no quad math has produced the figure you might expect.

The 2-D version of this set is:

So given all the knobbies in this fractal, you would expect to see the same in a 3-D version.

Alas, using quaternion math for the formula z=z-1, you get:
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which blurs all the knobbies like a lathe-like turning.

Using hypercomplex math (hypernion type fractal), you get:

which again blurs all the knobbies, this time in a squred-off way.

My experiment with complexified quaternion math (cquat) produces:

which interestingly enough retains some of the knobs and adds a lot of links that aren't in the original
2-D fractal.
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Fortunately, there are other quad maths that can be explored for their fractal producing
characteristics.

Using the random quad generator in Hydra, I discovered a quad matrix that seems to be the closest
approximation to what is needed to generate true 3-D Julia sets.

Since the matrix was found visually instead of logically, the image is shown first:

The squaring matrix for this fractal looks like:

i j k

i -1 k j

j k -1 i

k j i -1

and the derived iterative formula (for z^2+c) is:

x -> x*x - y*y - z*z - w*w + cx
y  -> 2.0*x*y + 2.0*w*z + cy
z -> 2.0*x*z + 2.0*w*y + cz
w -> 2.0*x*w + 2.0*y*z + cw

Considering that in the 2-D world the iterative formula for z^2+c is:
x -> x*x - y*y + cx
y  -> 2.0*x*y + cy

it seems that this quad math (which I have named Juliat) hits the target right on the button!

How strange that no algebraic rules have been established for this matrix, nor is it discussed
as a possible math for rendering 3-D fractals.

Note: these figures were all drawn using forty iterations, which gives a rather coarse 3-D
surface, but is necessary to fully reveal the shape of the Juliat fractal.    With 2-D fractals, the



Main Index 18

© 2008 -- Mystic Fractal

formulas are typically iterated 150 times or more.  At fewer than 20 iterations, Juliat fractals
appear to have dabs of paint spread across the figure.

2 Orca Remote

  Orca Remote

The remote provides access to many of the most-used commands in Orca.  Info about each
button can be obtained by using the '?' located near the close box in the top right-hand corner
of the remote.

2.1 Channel Guide

    Channel Guide

The four Demo channels accessed via the Orca remote:

3-D Julia: Random 3-D Julia set fractals

2-D Julia: Random 2-D Julia set fractals

Stalks: Random Orbit-trap Julia set fractals

Bubbles: Random Bubble-style Julia set fractals

2.2 New button

   New button

Use this button to open a new drawing window in Orca.  This is useful to view minor changes
to a drawing.  Use the Copy Data and Paste Data commands from the Edit menu to transfer
current drawing parameters to the new window.

2.3 Undo button

   Undo button

Use this command to undo the last action.  An image cannot be continued after an undo.

2.4 Size button

    Size button

This allows you to set the drawing area for a picture, independent of the Windows screen size.
It also shows which size is currently in use.  The aspect for the drawing is based on the ratio
of X (horizontal width) to Y (vertical height.)  The size of an image can range in standard 4/3
and 1/1 aspects from 160X120 to 3600X2700 or you can choose a custom XY size.  The
custom setting allows for any size/aspect that system memory will permit.   The minimum
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size for an image is 40X30.  Note:  Solid-guessing mode is disabled if the drawing aspect is
other than 4/3 or 1/1.  If the image is less than 100 width, the aspect must be 4/3 for solid
guessing to work properly.

2.5 Draw button

   Draw button

Use this button to draw or redraw the image for the current fractal variables.  Clicking inside
the draw window with the left-mouse button stops all plotting.  Use the Continue toolbar
button to restart plotting from the current column.

2.6 Batch button

    Batch button

Here you set parameters for batching and saving random-generated images to disk.  You can
also customize random variables to direct how the random scanning process works.

2.7 Text button

Text button

Edit 3-D texture-scaling variable.

2.8 Abort button

   Abort button

Use this command to stop drawing.  Clicking inside a window's drawing area or close box (or
the program close box) will also stop the drawing.  Note: once a plot has started Orca
continues to draw the image for that window regardless of which drawing window has the
input focus, until done or aborted.  You can open and close other drawing windows without
affecting the current drawing, but only one drawing is active at any time.

2.9 View button

    View button

Displays the entire plot, expanding or shrinking the image to fit in a maximized window
without title bar, scroll bars or menu bar.  At all other times, part of the picture is hidden by
the inclusion of the title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode,
press any key or click the left-mouse button.

2.10 Scan button

    Scan button
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This generates a 3-D or 2-D Julia set from a formula's Mandelbrot 'P' space.  Random points
in a formula's current Mandelbrot space are scanned for an interesting Julia set.  Rendering
options are maintained in the current fractal.  Equivalent to the 'F' hot key.

2.11 Rend button

    Rend button

The current lighting variables are applied.  This allows you to see what the surface texture
looks like while the fractal is drawing.

2.12 Help button

    Help button

Use this button to open the help index for Orca.

2.13 Palette button

    Palette button

Use the palette editor to modify the color palette in use.

2.14 Light button

    Light button

Edit lightpoint and viewpoint variables

2.15 Formula button

    Formula button

Use this button to change formula.

2.16 Params button

    Params button

Use this button to edit Fractal Parameters.

2.17 3-D Julia button

   3-D Julia button

A random 3-D fractal is generated.  The built-in formulas are scanned to find an interesting
Julia set, and then the parameters are adjusted to produce a 3-D image.  The ranges are reset,
Hj is set to 2.0, and the lighting is set for optimum viewing (if lighting is checked in the
Random Batch window.)
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Note: for some images an Hj value of 2.0 may result in a partially clipped image.  Sometimes
it helps to increase this value to 2.5 or 3.0, but too high a value may interfere with solid
guessing.

2.18 2-D Julia

   2-D Julia button

A random Julia fractal is generated.  Many of the built-in options of Orca are selected on a
random basis (if enabled in the Random Setup window), and the Mandelbrot space for one of
the twenty-two built-in formulas is scanned for an interesting Julia set.  The palette used is
also randomized (if Random coloring is selected.).  Note:  In most cases the Julia search is a
short one, but sometimes the "seek" mode can seem to get stuck when the criteria for an
interesting Julia set fails to match the formula used.  In the latter case, click the left mouse
button to restart the search process.  Tip: some things remain to be done after the Julia set is
drawn.  Feel free to experiment with all the parameters, reframe the image, change palettes
etc.  This routine provides a fast intro to many options in Orca that the user may be unfamiliar
with: no knowledge of fractal science/math required!  See the hot keys section also for a
description of the 'F' command.

2.19 Stalks

    Stalks button

A random Julia fractal is generated using one of Paul Carlson's orbit trap methods.

2.20 Bubbles

   Bubbles button

A random Julia fractal is generated using Paul Carlson's bubble method.

2.21 Random Render button

    Random Render button

The rendering styles of the current drawing are randomized, according to the options selected
in the Random Setup window.

2.22 Save button

   Save button

Use this button to save and name the active drawing.  Orca displays the Save As dialog box so
you can name your drawing.  To save a drawing with its existing name and directory, use the
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File/Save command.

2.23 Load button

   Load button

Use this button to open an existing data/image file in a new window.  Use the Window menu
to switch among the multiple open images.

2.24 Bmp button

   BMP button

Use this button to select the BMP format when loading and saving fractals.  This is the default
Windows bitmap format, readable by most Windows programs that use image files.  This is
also the fastest method of loading and saving fractals, but requires more disk space, since no
compression is used. Windows keeps track of the last six BMP files saved or loaded
(displayed in the Files menu.)

2.25 Png radio button

   PNG radio button

Use this button to select the PNG format when loading and saving fractals.  This format uses
medium compression without loss of image quality.

2.26 Jpg radio button

   JPG radio button

Use this button to select the JPEG format when loading and saving fractals.  This format uses
moderate compression but with some loss of image quality.  This is preferable for posting to
the net, since most browsers can display jpeg files.

2.27 ||||| button

    Write Avi button

Through a series of windows, this allows you to name and open an avi animation stream and
choose a compression method.  After using the file requester to name the file, you are given a
choice of compression methods.  The compression methods include Intel Indeo Video®,
Microsoft Video 1 and Cinepak Codec by Radius.  (All compression methods degrade the
original images, some more than others.)  The frames in the frame buffer are then written to
the avi stream and the stream closed.
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2.28 > button

   Add Key Frame button

Orca uses a frame buffer to compose an animation.  You add key frames to the buffer with this
command.  Each key frame is identical to the active image.  Change  variables between key frames to
create the illusion of motion or morphing.  You can edit the frames with the frame editor.

2.29 [] button

    [ ] button

Opens the frame editor window so you can edit frames in the video buffer by using any of the other
editor windows.  The Move button allows you to move a frame from one spot in the buffer to another.
You can change the frame image being edited by using the Frame slider or Edit box.  After changing
frames, use the Preview button to display the current frame being edited.  The Delete button allows
you to delete all but two of the frames, the minimum number of frames to create a movie.  (If you want
to delete all the frames, use the Video/Reset Frames command.)

2.30 V button

    V button

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file
name.  A multimedia box will appear to the right of the file list.  Click on okay to open the
main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto
rewind/repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing
speed.  A click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file.  Use the Save button to save the file in a
different compression format.  You must use a different name to save the file than the name
that was used to open it.  Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimedia file, including midi files.

3 File Menu

 File menu commands

The File menu offers the following commands:

New Creates a new drawing.
Open     Opens an existing drawing.
Close     Closes an opened drawing.
Save Saves an opened drawing using the same file name.
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Save As     Saves an opened drawing to a specified file name.
Load Parameters     Load parameters from an existing drawing.
Load Palette [PQZ]    Load palette file.
Load Texture     Load Orca texture file [QTX]
Open [JPG]     Load jpeg.
Open [PNG]     Load png.
Load Text Data [ORT] Load text (platform-independent) data file.
Save Parameters     Save parameters for an opened drawing to a specified file name.
Save Palette [PQZ]    Save palette to file.
Save Texture     Save texture file [QTX].
Save As [JPG]     Save in jpeg format.
Save As [PNG]     Save in png format.
Save Text Data [ORT] Save data in text (platform-independent) format.
Import Options

Palette [MAP]     Load a Fractint map file.
Export Options

Save as [OBJ]     Save polygonized 3-D fractal as Wavefront object.
Simplify     Simplify mesh.
Save as [POV]    Save polygonized 3-D fractal as a pov triangle object.
Smooth     Convert triangle mesh to smooth_triangle mesh.
Set Max Faces    Set target face size for mesh-simplification option.
Save As [STL] Save polygonized 3-D fractal as STL solid file.
Save as [WRL]    Save polygonized 3-D fractal as virtual reality file.
Save as [DXF]    Save polygonized 3-D fractal as AutoCad dxf file.
Save as [PLY]    Save polygonized 3-D fractal as Ply file.
Set Max Indices    Set maximum number of vertices allocated for Q polygon.
Exit Exits Orca.

3.1 New command

   New command (File menu)

Use this command to create a new drawing window in Orca.  The image and data for the
opening picture are used to create the new window.

You can open an existing data/image file with the Open command.

Shortcuts
Keys: CTRL+N

3.2 Open command

   Open command (File menu)

Use this command to open an existing data/image file in a new window.  Use the Window
menu to switch among the multiple open images.  See Window 1, 2, ... command.
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You can create new images with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O

3.2.1 File Open dialog box

File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.  This box lists files with the extension you
select in the List Files of Type box.

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which Orca stores the file that you want to open.

Directories
Select the directory in which Orca stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.

3.3 Close command

   Close command (File menu)

Use this command to close the window containing the active image.  If you close a window
without saving, you lose all changes made since the last time you saved it.

You can also close a drawing by using the Close icon on the drawing window, as shown
below:

3.4 Save command

   Save command (File menu)

Use this command to save the active drawing to its current name and directory.  When you
save a drawing for the first time, Orca displays the Save As dialog box so you can name your
drawing.  If you want to change the name and directory of an existing drawing before you
save it, choose the Save As command.
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Shortcuts

Toolbar:
Keys: CTRL+S

3.5 Save As command

   Save As command (File menu)

Use this command to save and name the active drawing.  Orca displays the
Save As dialog box so you can name your drawing.

To save a drawing with its existing name and directory, use the Save command.

3.5.1 Save As dialog box

File Save As dialog box

The following options allow you to specify the name and location of the file you're about to
save:
File Name

Type a new filename to save a drawing with a different name.  Orca adds the extension
.orc to the data file.

Drives
Select the drive in which you want to store the drawing.

Directories
Select the directory in which you want to store the drawing.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.

3.6 Load Other

3.6.1 Parameters command

   Load Parameters command (File menu)

Use this command to load a data file [.orc].  The data file contains all variables to recreate an
image created previously with Orca.

3.6.2 Palette command

   Load Palette command (File menu)

Use this command to load a palette file [.pqz].  The palette file contains a palette created
previously with Orca.  You also have the option in the file descriptor box to select palette and
coloring filter, to reload both palette and the coloring filter that was saved along with it.
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3.6.3 Texture command

   Load Texture command (File menu)

Use this command to load variables that make up the texture and noise parameters.  This also
loads the palette, coloring filter, orbit trap and coloring options in a texture file [qtx].

3.6.4 Open [JPG] command

   Open [JPG] command (File menu)

Use this command to load parameters and a bitmap file that were saved in jpeg format.  There
is an option in the file-type box to load only the bitmap too.  This replaces the Open
command for those who need a smaller sized bitmap file.  Note: the last files list doesn't keep
track of images loaded in JPEG format.

3.6.5 Open [PNG] command

   Open [PNG] command (File menu)

Use this command to load parameters and a bitmap file that was saved in png format.  There
is an option in the file-type box to load only the bitmap too.  This replaces the Open
command for those who need a smaller sized bitmap file.  Note: the last files list doesn't keep
track of images loaded in PNG format.

3.6.6 File Load Text Data [ORT) command

Load Text Data [ORT) command

Load text (platform-independent) data file.  The fractal data is entered into the active figure.

3.7 Save Other

3.7.1 Parameters command

   Save Parameters command (File menu)

Use this command to save all data elements for the current image in a data file [.orc].

3.7.2 Palette command

   Save Palette command (File menu)

Use this command to save a palette for the current image in a palette file [.pqz].  Also saves
the Coloring Filter used for surface mapping.
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3.7.3 Texture command

   Save Texture command (File menu)

Use this command to save the variables that make up the texture and noise parameters for the
current figure.  This also saves the palette, coloring filter, orbit trap and coloring options in
the texture file [qtx].

3.7.4 Save  As [JPG] command

   Save As [JPG] command (File menu)

Use this command to save the parameters and active bitmap in jpeg format.  There is an
option in the file-type box to save only the bitmap too.  This replaces the Save and Save As
command for those who need a smaller sized bitmap file.  Note: the last files list doesn't keep
track of images saved in JPEG format.

3.7.5 Save  As [PNG] command

   Save As [PNG] command (File menu)

Use this command to save the parameters and active bitmap in png format.  There is an option
in the file-type box to save only the bitmap too.  This replaces the Save and Save As
command for those who need a smaller sized bitmap file.  Note: the last files list doesn't keep
track of images saved in PNG format.

3.7.6 File Save Text Data [ORT) command

Save Text Data [ORT) command

Save the data for the active figure in text (platform-independent) format.

3.8 Import

3.8.1 Palette command

   Import -> Palette [MAP] command (File menu)

Use this command to load a Fractint-type map file.  The palette in the map file replaces the
currently selected palette.

3.9 Export

3.9.1 Save As [OBJ] command

   Export -> Save  as  [OBJ] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
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code (Quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the
triangles to a Wavefront object file.  The memory requirements for this routine are 20MB or
more for a typical Julia set 3-D fractal rendered at 320X240.  The output file can be very
large too, 4MB or more, depending on the precision required.  The higher the precision, the
smoother the finished object becomes.  Precision is set with the Steps variable in the Fractal
Parameters window, where precision=10/Steps.

Note: some formulas produce asymmetrical object files with this routine, where one side of
the q polygon isn't resolved completely.  Usually one side is markedly smoother in this case.

3.9.2 Simplify option

   Export -> Simplify option (File menu)

With this option selected (default on) if the Save as OBJ command is executed the resulting
polygon mesh is simplified according to Garland's QSlim algorithm before being output as a
Wavefront obj file.

3.9.3 Save As [POV] command

   Export -> Save  as  [POV] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a 3-D fractal formula, and then outputs the
triangles to a pov file.  The pov file is written as a simple scene, the triangles part of a "union"
object, with camera and lighting elements compatible with POV 3.5.  This can be used as a
starting point for more complex compositions.  The memory requirements for this routine are
20MB or more for a typical Julia set 3-D fractal rendered at 320X240.  The output file can be
very large too, up to 40MB or more, at the highest precision.  The higher the precision, the
smoother the finished object becomes.  Precision is set with the Steps variable in the Fractal
Parameters window, where precision=10/Steps.

Note: some formulas produce asymmetrical object files with this routine, where one side of
the q polygon isn't resolved completely.  Usually one side is markedly smoother in this case.

3.9.4 Smooth option

   Export -> Smooth option (File menu)

With this option selected (default on) smooth normals are calculated for the POV triangle
mesh and the polygonized object is output as a POV mesh with smooth_triangles.  Effective
when the Save as POV command is executed.

3.9.5 Set Max Faces command

   Export -> Set Max Faces command (File menu)

Here you can set the target face size for a Wavefront object, if the Simplify option is selected.
The face size can range from 1000 to 500,000 faces.  This allows you to reduce the size of the
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Wavefront object file by a factor of 30 or more and still retain the essential image detail.  Use
smoothing in Bryce to eliminate most of the triangle artifacts.  Before exporting the polygon
as an obj file, it helps to make the mesh resolution as high as practical by increasing the Steps
size in the Fractal Parameters window to a suitable value.  This varies with the complexity of
the 3-D figure.  The face size limits the object file size by reducing faces on the polygon until
the face limit is reached, so you never export a polygon with more than n-size faces.  It's
possible that there could be fewer faces than the face limit, and in that case no mesh
reduction is performed.  But usually you'll see a dramatic reduction in object faces (and obj
file size) if the Steps size is set to a value greater than 200 (the startup default).

3.9.6 Save As [STL] command

  Export -> Save As [STL] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the
triangles to a STL solid file.  STL files are used with 3-D printers and other machinery.  The
memory requirements for this routine are high, 20MB or more for a typical Julia set 3-D
fractal rendered at 320X240.  The output file can be very large too, 2MB or more, depending
on the precision required.  The higher the precision, the smoother the finished object.
Precision is set with the Steps variable in the Fractal Parameters window, where
precision=10/Steps.  See also the Simplify mesh command for ways to reduce object file size.

Note: some formulas produce unsymmetrical object files with this routine, where one side of
the q polygon isn't resolved completely.  Usually one side is markedly smoother in this case.

3.9.7 Save As [WRL] command

   Export -> Save  as  [WRL] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the
triangles to a virtual reality file.  The memory requirements for this routine are 20MB or more
for a typical Julia set 3-D fractal rendered at 320X240.  The output file can be very large too,
4MB or more, depending on the precision required.  The higher the precision, the smoother
the finished object.  Precision is set with the Steps variable in the Fractal Parameters window,
where precision=10/Steps.

Note: some formulas produce asymmetrical object files with this routine, where one side of
the q polygon isn't resolved completely.  Usually one side is markedly smoother in this case.

3.9.8 Save As [DXF] command

   Export -> Save  as  [DXF] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the
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triangles to an AutoCad dxf file.  The memory requirements for this routine are 20MB or
more for a typical Julia set 3-D fractal rendered at 320X240.  The output file can be very
large too, 4MB or more, depending on the precision required.  The higher the precision, the
smoother the finished object becomes.  Precision is set with the Steps variable in the Fractal
Parameters window, where precision=10/Steps.

Note: some formulas produce asymmetrical object files with this routine, where one side of
the q polygon isn't resolved completely.  Usually one side is markedly smoother in this case.

3.9.9 Save As [PLY] command

   Export -> Save  as  [PLY] command (File menu)

Use this command to save a 3-D fractal as a true 3-D object.  This uses John C. Hart's Implicit
code (Quaternion Julia Set server) to polygonize a 3-D fractal formula, and then writes the
triangles to a Ply (polygon format) object file.  The memory requirements for this routine are
20MB or more for a typical Julia set 3-D fractal rendered at 320X240.  The output file can be
very large too, 4MB or more, depending on the precision required.  The higher the precision,
the smoother the finished object becomes.  Precision is set with the Steps variable in the
Fractal Parameters window, where precision=10/Steps.

Note: some formulas produce asymmetrical object files with this routine, where one side of
the q polygon isn't resolved completely.  Usually one side is markedly smoother in this case.

3.9.10 Set Max Vertices command

   Set Max Indices (File menu)

Use this command to set the maximum number of indices that are allocated by the
polygonizing routine.  Default is 5,000,000 indices.  Use less to limit the amount of memory
used while polygonizing.  Use more if necessary for higher resolution.  Note:  unless you have
an application that can use very large object files, there's a limit to how much resolution is
obtainable with the polygonizing routine.  Bryce4 has problems with object files produced by
Orca that are much larger than 2.5MB (on systems other than Win XP.)

3.10 File 1, 2, 3, 4, 5, 6 command

   1, 2, 3, 4, 5, 6 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last six
drawings you closed.  Choose the number that corresponds with the drawing you want to
open.
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3.11 Exit command

  Exit command (File menu)

Use this command to end your Orca session.  You can also use the Close command on the
application Control menu.  Note: if you choose to exit while plotting, the program does not
terminate, but stops the plotting so the program can be safely exited.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4

4 Edit Menu

  Edit menu commands

The Edit menu offers the following commands:

Undo Undo last edit, action or zoom.
Copy     Copy the active view and put it on the Clipboard.
Clip     Define area of view and copy to clipboard.
Paste     Insert Clipboard contents.
Copy Data     Copy fractal data to buffer.
Paste Data     Paste data from copy buffer.
Formula Parameters     Edit formula parameters.
Drawing Parameters Edit drawing window parameters.
Size     Sets the image size.
Fractal Parameters     Edit fractal parameters.
Ray-Tracing Variables     Edit lighting and viewpoint variables.
Palette Editor Edit palette.
Preferences    Startup preferences and defaults.

4.1 Undo command

   Undo command (Edit menu)

Use this command to undo the last action.  An image cannot be continued after an undo.

Shortcut
Keys: CTRL+Z
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4.2 Copy command

   Copy command (Edit menu)

Use this command to copy the active view to the clipboard.  The entire view is copied to the
clipboard.

Shortcut
Keys: CTRL+C

4.3 Clip command

   Clip command (Edit menu)

Use this command to copy a part of the active view to the clipboard.  A zoom box is used to
select the part to be copied.  Click outside the view frame or press escape to exit this option.

Shortcut
Keys: CTRL+L

4.4 Paste command

   Paste command (Edit menu)

Use this command to paste from the clipboard.  The clipboard must contain a bitmap.  If the
bitmap is larger than the view, it is clipped.  The zoom cursor is used to set the left/top corner
in the view where the bitmap will be pasted.  Click outside the view frame or press escape to
exit this option.

Shortcut
Keys: CTRL+V

4.5 Copy Data command

   Copy Data command (Edit menu)

Use this command to copy the fractal data for the active view to the file "c:\zcopy.orc".  The
current palette for the view is also copied.

Shortcut
Keys: CTRL+F
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4.6 Paste Data command

   Paste Data command (Edit menu)

Use this command to paste the data in the file "c:\zcopy.orc" to the active view.

Shortcut
Keys: CTRL+R

4.7 Formula Parameters

    Formula Parameters

Function is the combo control for selecting the formula used to generate the fractal.  There
are additionally two fractal Type controls, an Arg control, and an 'S' control that are used in
various fractal formulas and user-defined functions.  User-defined functions are supplied
through list boxes fn1 and fn2.  Although there are only 20 built-in formulas in Orca, all of
the formulas are generalized and can use up to two user-defined functions (out of a total of
52) and two fractal types, from a list of four types, quaternion, hypernion, compquat and
juliat.  These Types specify the type of quad math used in calculating the formula.  The types
are switched at various stages of the formula calculations, so that in effect you can merge the
two fractal types into a totally different fractal type, a hybrid type, if you want.  Note: some
user-defined functions are only defined as quaternion or hypercomplex (hypernion) math.
When the fractal type is neither of these, the math defaults to hypercomplex.  This is true for
all transcendental, logarithmic and power functions, except w^(int)s.

The Bail box is used to enter an optional bailout string, such as "|z|<4" or "z=sin(z), x<4"
(without the quotes).  This supersedes any bailout defined by the Mapping menu and Bailout
variable in the Fractal Parameters window. A list of functions supported by the Bail box is
listed in Parser Information.

The three buttons named Random function, Random fn1-fn2, and Random Types are used to
pick formulas, functions, or types at random.  Clicking on Random Function a formula is
chosen (from the 20 built-in formulas) for Function.  Clicking on Random f1-f2 randomizes
both user-defined functions.  Clicking on Random Types, both fractal types are randomized.

Click on the Okay button to use the formulas currently displayed in the window, or Cancel to
exit the window without making any changes.  Click on Apply to apply a new formula, etc.
without closing the Formula window.

The Reset button returns all boxes and slider values to their original values when the window
was opened.
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4.8 Drawing Parameters

    Drawing Parameters Window

The Size slider controls the overall size of the picture.  The Size slider sets the horizontal
resolution, while the vertical resolution is then scaled according to the full-screen VGA ratio,
4 to 3 (1:1 if that aspect is selected through the Size option.)  The Sector slider controls which
of 4 sectors the picture will be drawn in, if the Size is less than or equal to (the full-screen
horizontal resolution)/2.  Otherwise the picture is centered according to the full-screen
dimensions.  This allows you to show zooms of a particular function by using different
sectors, or show the affect of different plotting options.  Each sector is erased individually.
Note: if you try to continue a plot in a different sector than you started with, the plot will
continue in the original sector.  The Thumbnail button next to the Size slider is used to set a
thumbnail size quickly.  The thumbnail size toggles between 1/4 and 1/8 of the horizontal
screen resolution, e.g. 200X150 or 100X75 for an 800X600 screen.

Select the Okay button to start a new plot from column 1.

The Reset button returns all boxes and slider values to their original values when the window
was opened.

Related Topic:
Fractal Parameters describes the fractal generator's data-collection window.

4.9 Size command

    Size (Edit menu)

This allows you to set the drawing area for a picture, independent of the Windows screen size.
It also shows which size is currently in use.  The aspect for the drawing is based on the ratio
of X (horizontal width) to Y (vertical height.)  The size of an image can range in standard 4/3
and 1/1 aspects from 160X120 to 3600X2700 or you can choose a custom XY size.  The
custom setting allows for any size/aspect that system memory will permit.   The minimum
size for an image is 40X30.  Note:  Solid-guessing mode is disabled if the drawing aspect is
other than 4/3 or 1/1.  If the image is less than 100 width, the aspect must be 4/3 for solid
guessing to work properly.

4.10 Fractal Parameters

    Fractal Parameters Window

This is the data-collection window for the 3-D and 2-D generators.

Min Z and Max Z define the third dimension Z space that is used to map the quad image.
Normally Min Z is the negative of Max Z, but Min Z can be adjusted in the positive direction
to shear off the front of the quad object.  This has the effect of exposing the insides of a quad
set.
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Quad constants are cr, ci, cj and ck.

Three rotate variables determine the 3-D angle of rotation.

The Bailout variable can range from .000001 to 65000.  For most escape-time formulas that
have an attractive point at infinity, the bailout is set to a value 4 or greater.  A larger value
tends to make the 3-D figure smoother and fuller with some loss of detail.

Steps and Fine Tune are pitch adjustments that bear on the quality of the 3-D plot at the
expense of lengthier calculations.

The Slice variables may be altered to display different planes of the quad set.

Use the Random Rotate button to set random values (0-360) for the Rotation variables.

The scaling variable is used with 2-D plots to increase or decrease color useage, and with
bubble and orbit-trap methods when used as 2-D fractals or 3-D surfaces.  Selecting the
Carlson option (in the Orbit-Traps window) or clicking on the Bubble Extensions button (in
the coloring options window) automatically adjusts this variable to a suitable value.  Hint:
increase its magnitude to make the bubbles larger, but keep the value negative.

4.11 Ray-Tracing Variables

    Ray-Tracing Window

The LightPoint variables (lightx thru lightz) determine the direction of the light source used in
the ray-tracing algorithm.  The ViewPoint represents the angle, at which the object is ray-
traced, which can affect Phong highlights greatly.  This has no effect on the camera view.

The Lighting variables shininess, highlight, gamma and ambient are used to adjust ambient
light and highlights.  The ranges for these variables appear beside their label.  Decreasing the
shininess value increases light reflected by the 3-D fractal and the apparent sheen on the 3-D
fractal's surface.  The ambient value controls the amount of ambient light that illuminates the
3-D fractal.  The highlight value increases or decreases the specular (Phong) highlighting,
while the gamma value increases or decreases the intensity of the light source's illumination.
Once a plot is started, the lighting variables and light point can be changed without redrawing
the 3-D fractal.

Click the Apply button to redisplay a plot after changing the lighting variables or light point.
Click the Okay button to close the Ray-Tracing Window, applying new settings, if the
variables were modified.  Click on Cancel to revert to the state that existed when the ray-
tracing window was opened.  Click on Defaults to set the lighting and viewpoint variables to
the built-in defaults for these variables.



Orca  Application Help37

© 2008 -- Mystic Fractal

4.12 Palette command

    Palette command (Edit menu)

Use the palette editor to modify the palette(s) in use.

It is important to realize that palettes are software-simulated in Orca (since 24-bit color
supports no hardware palettes), so color cycling and palette switching are not fast operations
as with a 256-color system that supports palettes.

There are copy and spread options to smooth or customize the existing palettes in Orca.  You
can then save all the palettes in a .pl file, or by saving the entire function and bitmap.

Colors are shown in 8 groups of 32 colors.  This makes it easy to create split palettes from
256 color indexes.  With Orca, a palette is actually 65280 colors, with each succeeding color
(except the last) followed by 255 colors that are evenly spread from one color to the next.
The background color is shown separately, as it is not used to derive split palettes.

Use the RGB-slider controls to edit any color in the palette.  Select Copy to copy any color to
another spot in the palette. Select Spread to define a smooth spread of colors from the current
spot to another spot in the palette.  Copy and Spread take effect immediately when you select
another spot with the mouse button.  You can cancel the operation with the Cancel button.  In
Orca, colors do not cycle smoothly when you adjust the RGB/HSV sliders.  This would be too
slow with true color.  The Map button is used to map color changes to an image after you are
done adjusting the sliders.  In the HSV mode, color spreads are based on HSV values instead
of RGB values, which in some cases results in brighter color spreads.

Right-click on any point on the main window and the palette color for that pixel will be
displayed in the palette editor.  You can use any of the color-cycling keys (after clicking on
the main window) to see the effects of the cycling in the palette editor window.   Note:  color
cycling and color-selection-from-pixel only works when the image has been drawn in the
current session.  If you load a pre-existing image file, you must redraw it to cycle colors, etc.
Anti-aliasing, and the composite figure option also disable color cycling.

Use Reset to reset the colors of the palette in use, to where it was before it was cycled or
modified.  Note: if you change palettes with one of the function keys, any modifications to a
previous palette are unaffected by the Reset button.

Use Reverse to reverse the order of the colors in the palette.  This affects only those colors in
the start-color to end-color range.

Use Neg to create a palette that is the complement of the current palette.

Use SRG to switch the red and green components of all palette colors.
Use SRB to switch the red and blue components of all palette colors.  SRB and SRG are
disabled in HSV mode.  You can use these buttons to form eight different palettes by
repeatedly switching red, green and blue components.
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Use the Random palette button to randomize the current palette.  The Randomize variables,
rmin, rmax, bmin, bmax, gmin, and gmax act as limits that are applied after the palette after
initial randomizing, to make the palette conform to the desired spectrum of colors.

Note: unless you click on Reset before exiting the editor, changes are permanent to the palette
edited, no matter which way you close the editor (Okay button or close box.)

4.12.1 Reverse button

    Reverse button

Use Reverse to reverse the order of the colors in the palette.  This affects only those colors in
the start-color to end-color range.  This is useful for reversing divide-by-eight palettes, etc.,
for orbit-trap pictures that require a reversed palette.

4.12.2 Neg Button

    Neg button

Use Neg to create a palette that is the complement of the current palette.

4.12.3 Map Button

    Map button

In Orca, colors do not cycle smoothly when you adjust the RGB/HSV sliders.  This would be
too slow with true color.  The Map button is used to map color changes to an image after you
are done adjusting the sliders.

4.12.4 H/R Button

    H/R button

Change from HSV to RGB mode or back.  In the HSV mode, color spreads are based on HSV
values instead of RGB values, which in some cases results in brighter color spreads.

4.12.5 Spread Button

    Spread button

Select Spread to define a smooth spread of colors from the current spot to another spot in the
palette.

4.12.6 Copy Button

    Copy button

Select Copy to copy any color to another spot in the palette.
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4.12.7 SRG Button

    SRG button

Use SRG to switch the red and green components of all palette colors.  This is for RGB mode
only.

4.12.8 SRB Button

    SRB button

Use SRG to switch the red and blue components of all palette colors.  This is for RGB mode
only.

4.12.9 Okay Button

    Okay button

Click on Okay to exit the palette editor, applying unmapped color changes to picture (if color-
cycling is enabled.)

4.12.10 Reset Button

    Reset button

Use Reset to reset the colors of the palette in use, to where it was before it was cycled or
modified.  Note: if you change palettes with one of the function keys, any modifications to a
previous palette are unaffected by the Reset button.

4.12.11 Cancel Button

    Cancel button

You can cancel a copy or spread operation with the Cancel button.

4.12.12 Red Slider

    Red slider

Use the RGB/HSV-slider controls to edit any color in the palette.

4.12.13 Green Slider

    Green slider

Use the RGB/HSV-slider controls to edit any color in the palette.

4.12.14 Blue Slider

    Blue slider

Use the RGB/HSV-slider controls to edit any color in the palette.
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4.12.15 Red edit box

    Red edit box

Shows red/hue value of selected color index.

4.12.16 Green edit box

    Green edit box

Shows green/saturation value of selected color index.

4.12.17 Blue edit box

    Blue edit box

Shows blue/value magnitude of selected color index.

4.12.18 Random Palette Button

    Random palette button

Use to create a random palette.  Fast way to define palettes.

4.13 Preferences command

    Preferences (Edit menu)

Each time you use the Reset command, Orca restores data variables to built-in defaults.  The
Set Defaults button allows you to change some of the data variable defaults to whatever the
current settings are.  Some of the customizable variables include step, fine, formula,
viewpoint, lighting, rotational angles, Phong and x/y space.  The new Reset defaults are saved
in the file "prefs.txt" when you close the program (if the Defaults check box is selected.)  The
check boxes in the group "Save on Program Close" allow you to change the default startup
mode of a few Auto options, such as Auto Redraw, and the Random Setup variables.  By
keeping the boxes selected, Orca saves the last changes you make to these options.  If you
want to go back to the initial settings (the way Orca was packaged originally) you can click
on the Reset Defaults button.  This restores the data, Auto variables and random setup
defaults.

Use the Default Directories tab to change the default directories for saved and loaded items in
Orca.  Click on the "…" button next to each default directory box, and use the folder
requester to pick a different directory, or create a new directory with the Make New Folder
button.  The default directories are saved at program close in the Registry and reloaded when
you next open Orca.
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5 Image Menu

  Image menu commands

The Image menu offers the following commands:

Draw Draw the picture.
Draw Composite Draw composite from figures 1-4.
Plot To File Plot large bitmap images directly to png file.
Plot Files In Directory Disk render .orc files in working directory.
Auto Redraw    Redraw image on command.
Auto Clear     Clear drawing area before new plot.
Auto Remote Open remote automatically at startup.
Merge Sum     Merge current pixel color with previous color summing colors.
Merge And     Merge current pixel color with previous color anding colors.
Merge Or     Merge current pixel color with previous color oring colors.
Merge High    Merge current pixel color with previous color by choosing highest
rgb.
Merge Low     Merge current pixel color with previous color by choosing lowest
rgb.
Merge Black     Merge current pixel color with previous color by excluding
black (0,0,0).
Merge Diff     Merge current pixel color with previous color by using difference of
colors.
Hide Dialogs Hide dialogs for active drawing.
Show Dialogs    Show drawings for active drawing.
Abort     Abort drawing.
Continue     Continue drawing.
Zoom     Zoom into rectangle.
New View on Zoom New view on zoom.
Clone    Clone current view.
Pilot     Use Pilot to rotate figure and alter key cubic variables.
Scan Scan Mandelbrot border for 3-D fractal Julia set.
Dive Peel off outer layer of 3-D fractal.
Ray Trace  Ray trace 3-D plot.
Reset Ranges Reset z-space
Reset Figure     Reset current figure
Figure 1     Switch to figure one.
Figure 2     Switch to figure two.
Figure 3     Switch to figure three.
Figure 4     Switch to figure four.
Composite  Select figures to merge.
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5.1 Draw command

   Draw command (Image menu)

Use this command to draw or redraw the image for the current fractal variables.  Clicking
inside the draw window with the left-mouse button stops all plotting.  Use the Continue
command to restart plotting from the current column.

5.2 Draw Composite command

   Draw Composite command (Image menu)

Use this command to draw or redraw an image defined in the Composite command as a
merging of figures 1-4.  Clicking inside the draw window with the left-mouse button stops all
plotting.  Continue is disabled for this command.

5.3 Plot to file

   Plot to File (Image menu)

This allows you to plot a large bitmap directly to a .png file without the added system
requirements of keeping the whole bitmap in memory.  The Target group sets the bitmap
resolution (width 800 to 14400.  Drawing aspect is that of the current image.)  Click on Okay
to set the target file name and start a new plot to file.  Note: the 3200X2400 bitmap size is
suitable for 8 1/2X11 printouts at 320-720 dpi.  The larger bitmap sizes are suitable for
poster-size printouts.  This option is not available with the merging options, or with anti-
aliasing.  Also, solid guessing is disabled when using this option.

5.4 Plot Files in Directory

   Plot Files in Directory (Pixel menu)

Allows you to plot a set of large bitmaps directly to a .png files without the added system
requirements of keeping any of the images in memory.  The Target group sets the bitmap
resolution (width 800 to 14400.  Drawing aspect is that of the current image.)  All data files
(.orc) in the working directory are enlarged to this resolution.  Click on Okay to start.  Note:
the 3200X2400 bitmap size is suitable for 8 1/2X11 printouts at 320-720 dpi.  The larger
bitmap sizes are suitable for poster-size printouts.  Merging, anti-aliasing and solid guessing
are disabled when using this option.

5.5 Auto

5.5.1 Redraw command

   Auto Redraw command (Image menu)

With this command disabled (on by default), redraw does not occur except when the Draw
command is executed, or Continue.  Most of the time you want to see the results of changing
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a parameter or mapping option, so redraw occurs automatically with parameter or mapping
changes.  Sometimes you want to change more than one parameter before redrawing the
image.  So you need to turn this option off then.

5.5.2 Clear command

   Auto Clear command (Image menu)

With this command enabled (on by default), the drawing area is cleared before starting a new
plot.  You can turn off this option when you want to see the effect of minor changes to
parameters, as they affect the plot pixel by pixel, or when setting up a multiple-layered
fractal.  Note: when you disable auto clear, no pre-image is drawn while the image is being
calculated, and any background image (loaded through Open [Jpeg] or Open [Png]) is
retained.  You can use the shift-c command (hot keys) to clear the drawing area at any time.

5.5.3 Auto Remote command

   Auto Remote command (Image menu)

With this command enabled (on by default), the remote is opened immediately at program
startup.  Handy if you find the remote useful and don't want to click on the toolbar button
each time the program starts up.

5.6 Merge Colors

5.6.1 Merge Sum command

   Merge Sum command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn.  Instead the colors are merged using a summing algorithm.  The auto-
clear option must be disabled and solid guessing off to choose this option.  This is useful to
merge two or more separate fractal images/types with the initial image(s) "bleeding" through.

5.6.2 Merge And command

   Merge And command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn.  Instead the colors are merged using an anding algorithm.  The auto-
clear option must be disabled and solid guessing off to choose this option.  This is useful to
merge two or more separate fractal images/types with the initial image(s) "bleeding" through.

5.6.3 Merge Or command

   Merge Or command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn.  Instead the colors are merged using an oring algorithm.  The auto-clear
option must be disabled and solid guessing off to choose this option.  This is useful to merge
two or more separate fractal images/types with the initial image(s) "bleeding" through.
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5.6.4 Merge High command

   Merge High command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn.  Instead the colors are merged using the highest rgb values of both
images.  The auto-clear option must be disabled and solid guessing off to choose this option.
This is useful to merge two or more separate fractal images/types with the initial image(s)
"bleeding" through.

5.6.5 Merge Low command

   Merge Low command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn. Instead the colors are merged using the lowest rgb values of both
images.  The auto-clear option must be disabled and solid guessing off to choose this option.
This is useful to merge two or more separate fractal images/types with the initial image(s)
"bleeding" through.

5.6.6 Merge Black command

   Merge Black command (Image menu)

With this command enabled (off by default), the current pixel color is not overwritten when a
new image is drawn. Instead the colors are merged using the rgb components of the new
image, if the current pixel color is black (0,0,0).  The auto-clear option must be disabled and
solid guessing off to choose this option.  This is useful to merge two or more separate fractal
images/types with the initial image(s) "bleeding" through (i.e. if the background color of the
initial image is black).

5.6.7 Merge Diff command

   Merge Diff command (Image menu)

With this command enabled (off by default), current pixel color is not overwritten when a
new image is drawn. Instead the colors are merged using the difference of the rgb values of
both images.  The auto-clear option must be disabled and solid guessing off to choose this
option.  This is useful to merge two or more separate fractal images/types with the initial
image(s) "bleeding" through.

5.7 Hide dialogs command

   Hide dialogs command (Image menu)

Use this command to hide all open non-modal dialogs in the active window.  This helps to de-
clutter the screen and avoid confusion if two or more draw windows are open.  Each draw
window has its own dialogs.  Disabled if no dialogs are open.
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5.8 Show dialogs command

   Show dialogs command (Image menu)

Use this command to show all open non-modal dialogs in the active window.  This command
restores any dialogs that may have been hidden by the Hide dialogs command.  Each draw
window has its own dialogs.  Disabled if no dialogs are open or hidden.  Note: you can restore
individual dialogs by selecting the command that opened them originally.

5.9 Abort command

   Abort command (Image menu)

Use this command to stop drawing.  Clicking inside a window's drawing area or close box (or
the program close box) will also stop the drawing.  Note: once a plot has started Orca
continues to draw the image for that window regardless of which drawing window has the
input focus, until done or aborted.  You can open and close other drawing windows without
affecting the current drawing, but only one drawing is active at any time.

5.10 Continue Draw

    Continue Draw (Image menu)

Continues a plot that was aborted early.  The plot is restarted at the beginning of the last row
drawn.  Continue is disabled when an Image/Merge option is selected.  Continue isn't
available for 3-D images that have been reloaded from a previous drawing session or after an
Undo.

5.11 Zoom command

   Zoom (Image menu)

Turns on zoom mode, so that detail of the current plot may be magnified.  Alternatively, just
click inside any drawing window, move the mouse, and the zoom box will appear.  Using the
mouse, move the zoom box over the portion of the plot you wish to magnify.  Hold the left
mouse button to shrink the box or the right button to enlarge it.  Use the up and down arrow
keys to squash or expand the box, changing the aspect of the image.  Use the left and right
arrow keys to rotate the box counter-clockwise or clockwise (2-D map only).  Use the Shift
key to enlarge the zoom box X4 for quickly zooming outward.  Use the Ctrl key to shrink the
zoom box by 4.  You start a zoom by pressing the space bar.  You abort a zoom by clicking
outside the main window or in the title bar, or by pressing the escape key. The program will
begin a new plot at the new coordinates.  You may zoom in by defining a box inside the
current drawing area.  You zoom out by drawing a box outside the current drawing area.  The
outer zoom limits are between -1000 and 1000.
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5.12 New View on Zoom command

    New view on zoom (Image menu)

With this option enabled, a new window is opened with each zoom, instead of the zoom box
area replacing the original image.  Ignored in avi mode.

5.13 Clone command

    Clone (Image menu)

A new draw window is opened that contains the same fractal data as the window it was
opened from.  This is useful for comparing minor changes in texturing options, etc.  Similar
to using the copy/paste data commands except that all figures are copied to the new view.

5.14 Pilot command

    Pilot (Image menu)

Opens the Pilot window to adjust key parameters, rotate, zoom and redraw the figure
interactively.  The current image is reduced to one quarter normal for faster redraw.  Each
click on a Pilot button increments or decrements a parameter.  The Speed slider controls the
rate at which the buttons operate (default is 10.)

Press the space bar or Click on Ok to open a new window and draw the altered image full-
size.  Press Esc or click on Cancel to exit this mode without opening a new window.  Note:
when using this option while an AVI stream is open, a new window isn't opened, but the
altered figure is drawn in the current draw window, the changed parameters replacing the
previous ones.

5.15 Scan command

    Scan (Image menu)

This is equivalent to the Shift+G hot key when the Type is 3-D Map or Shift+J hot key  if the
Type is 2-D Map.

5.16 Dive command

    Dive (Image menu)

Select Dive to go beneath the surface of a 3-D fractal.  Some 3-D fractals have a smooth
border that doesn't show the turbulence below the surface.  Using the Dive option strips off
the border layer to reveal what's underneath, if anything, else the border layer is retained.
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5.17 Ray Trace command

    Ray Trace (Image menu)

Uses Frode Gill's ray-tracer algorithm to add a light source to 3-D plots.  Color palettes should
be continuous (dark to light to dark) to take best advantage of this option.  The light source
parameters may be altered in the Ray-Tracing Variables window.  This option is the default.
Note: if you prefer to generate 3-D fractals without ray tracing, deselect this flag before
drawing the plot.  The image draw will be the pre-image, using the existing palette, as is,
without ray-tracing (Phong or shading.)

5.18 Full Screen command

    Full Screen (Image menu)

Displays the entire plot, expanding or shrinking the image to fit in a maximized window
without title bar, scroll bars or menu bar.  At all other times, part of the picture is hidden by
the inclusion of the title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode,
press any key or click the left-mouse button.

5.19 Reset Ranges

Reset Ranges

The Ranges Only command resets only the real Z and imaginary Z ranges in the Parameters
window (to +/-2.0 and +/-1.5.)  No other menus or variables are affected.  This is useful in
conjunction with the "P" command to generate and view Julia sets.  After setting the
complex-C variable via shift-P (Caps Lock off), you need to reset the Z ranges to see the
entire Julia set after zooming into a Mandelbrot set.

5.20 Reset Figure

    Reset Figure

Reset the current figure or all figures to an empty Mandelbrot.  All functions in the New
Formula data are blanked.  All options on the Flags menu are reset to their default settings.

5.21 Figure

5.21.1 1

    Figure #1 (Image menu)

Switch to Function #1.  Current settings are saved for the previous image.
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5.21.2 2

    Figure #2 (Image menu)

Switch to Function #2.  Current settings are saved for the previous image.

5.21.3 3

    Figure #3 (Image menu)

Switch to Function #3.  Current settings are saved for the previous image.

5.21.4 4

    Figure #4 (Image menu)

Switch to Function #4.  Current settings are saved for the previous image.

5.21.5 Composite command

   Composite command (Image menu)

Opens the Composite Figure window, where you can define a set of figures to merge into one
image.  All the merging options in the Merge Color menu are supported, plus "ALL" which is
usually used for the first figure to be drawn.  The "ALL" option transfers all rgb information
for a figure to the drawing area, without checking the rgb state of the pixel.  You can define
up to four figures (layers), as part of the composite, but each figure should contain an image
(if used in the composite.)

6 Type Menu

 Type menu commands

The Type menu offers the following commands:

2-D Map Set fractal type to two-dimensional mapping.
3-D Map Set fractal type to three-dimensional mapping.
Mandelbrot0 Mandelbrot set (orbit starts at zero.)
MandelbrotP   Mandelbrot set (orbit starts at zpixel.)
Julia     Julia set.

6.1 2-D Map

The fractal type is set to 2-D.  Use this command to create standard 2-D fractals.  Bailout, max
iterations and complex 'c' are set in the Fractal Parameters window.

6.2 3-D Map

The fractal type is set to 3-D.  Use this command to create true 3-D fractals.  The figure dynamics
vary with the type of quad math used.  The math type is set in the Formula Parameters window.



Orca  Application Help49

© 2008 -- Mystic Fractal

6.3 Mandelbrot0

    Mandelbrot0 (Type menu)

Mandelbrots base their mapping on varying inputs of complex C, which corresponds to the
min/max values set in the Parameters window.  With Mandelbrot0, the initial value of Z is set
to zero.

6.4 MandelbrotP

    MandelbrotP (Type menu)

Mandelbrots base their mapping on varying inputs of complex C, which corresponds to the
min/max values set in the Parameters window.  With MandelbrotP, the initial value of Z is set
to the value of the pixel being iterated.

6.5 Julia

    Julia (Type menu)

Julia sets normally have a fixed complex C, with varying inputs of Z.  This option generates
the so-called 'filled-in' Julia set, which includes non-escaping points as well as the Julia set.

Julia from Mandelbrot

Julia set

7 Map menu

  Map menu commands

The Map menu offers the following commands:

Z-Real-Z-Imag Mapping based on difference of real and
imaginary parts of Z.
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Z-Real*Z-Real/Z-Imag*Z-Imag  Mapping based on real part of Z squared divided by
imaginary part of Z squared.
Z-Imag*Z-Imag/Z-Real*Z-Real  Mapping based on imaginary part of Z squared divided
by real part of Z squared.
(Z-Real*Z-Real+Z-Imag*Z-Imag)/Z-Real*Z-Real  Mapping based on absolute value of of Z
divided by real part of Z squared.
(Z-Real*Z-Real-Z-Imag*Z-Imag)/Z-Imag*Z-Imag  Mapping based on the difference of  Z
parts squared divided by the imaginary part of Z squared. 
Abs(Z-Real)*Abs(Z-Imag)  Mapping based on product of absolute value of parts of Z.
>Abs(Z-Real) or Abs(Z-Imag) Mapping based on highest absolute value of parts of z.
<Abs(Z-Real) or Abs(Z-Imag  Mapping based on lowest absolute value of parts of z.
Abs(Z) Mapping based on absolute value of z.

Mapping supplies the bailout criteria for the iterative loops, both 3-D and 2-D fractal types.

7.1 Z-Real-Z-Imag

    Z-Real-Z-Imag
Mapping based on difference of real and imaginary parts of Z.

7.2 Z-Real*Z-Real/Z-Imag*Z-Imag

    Z-Real*Z-Real/Z-Imag*Z-Imag
Mapping based on real part of Z squared divided by imaginary part of Z squared.

7.3 Z-Imag*Z-Imag/Z-Real*Z-Real

    Z-Imag*Z-Imag/Z-Real*Z-Real
Mapping based on imaginary part of Z squared divided by real part of Z squared.

7.4 (Z-Real*Z-Real+Z-Imag*Z-Imag)/Z-Real*Z-Real

    (Z-Real*Z-Real+Z-Imag*Z-Imag)/Z-Real*Z-Real
Mapping based on absolute value of of Z divided by real part of Z squared.

7.5 (Z-Real*Z-Real-Z-Imag*Z-Imag)/Z-Imag*Z-Imag

    (Z-Real*Z-Real-Z-Imag*Z-Imag)/Z-Imag*Z-Imag
Mapping based on the difference of  Z parts squared divided by the imaginary part of Z
squared.  Changes the way banding appears in complex mappings.

7.6 Abs(Z-Real)*Abs(Z-Imag)

    Abs(Z-Real) * Abs(Z-Imag)
Mapping based on product of absolute value of parts of Z.  Changes the way banding appears
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in complex mappings.

7.7 >Abs(Z-Real) or Abs(Z-Imag)

    >Abs(Z-Real) or Abs(Z-Imag)
Map based on the greater of the absolute value of the real part or the imaginary part of the
complex number Z.  Works like a logical 'or', where either part of z must exceed zlimit to
break the iteration loop.  Changes the way banding appears in complex mappings.

7.8 <Abs(Z-Real) or Abs(Z-Imag)

    <Abs(Z-Real) or Abs(Z-Imag)
Map based on the lesser of the absolute value of the real part or the imaginary part of the
complex number Z.  Works like a logical 'and', where both parts of z must exceed zlimit to
break the iteration loop.  Changes the way banding appears in complex mappings.

7.9 Abs(Z)

    Abs(Z)
Map based on the absolute value of the complex number Z (traditionally calculated by taking
the square root of the sum of the squares of the real and imaginary parts of Z, but Orca uses
only the 'sum'(modulus of z) for break-point tests.)  The standard method of mapping Julia
and Mandelbrot sets.

8 Render Menu

  Render menu commands

The Render menu offers the following commands:

Orbit Trap Options  Set orbit trapping method.
Use Pic as Trap Color Use image in clipboard for orbit-trap coloring.
Process Bailout  Process bailout from orbit-trap, bubble or biomorphic option.
Divide By One Palette No split palette.
Divide By Two Palette Split palette into two sections.
Divide By Four Palette Split palette into four sections.
Divide By Eight Palette Split palette into eight sections.
Divide By Sixteen Palette Split palette into sixteen sections.
Divide By Thirty-Two Palette Split palette into thrity-two sections.
Texture Scale  Set scaling factor for 3-D texture.
Add Noise  Add noise to coloring.
Factors  Edit noise factors.
Reset Noise Seed  Re-seed random noise generator.
Filter  Choose an optional tail-end filter.
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8.1 Coloring Options

     Coloring Options

The following options are described as 2-D coloring options,  but the Level Curve,
Biomorphic and Decomposition  options are also used for 3-D renderings.

Inside Coloring Options

Level Curves
Level-curves map the set points based on the value of Z.  This allows the inside of the
complex set to be color-scaled.

Log Map
produces colored bands on the inside of the complex set.  Points are mapped according to
what the value of z is at final iteration.

Log Map

Small Log
produces circular patterns inside the complex set.  Points are mapped according to the
smallest value z gets during iteration.

Small Log

Atan Coloring
Uses an algorithm by David Makin to color an image.  The angle of each point (as it escapes
the set border) is used to color the image.

Bof60 Coloring
A variation of the Bof60 algorithm found in the classic Pietgen/Ricter text, The Beauty of
Fractals, adapted by David Makin, is used to color an image.  The smallest magnitude of z
(found while calculating the set border) is used to render the image.

Linear Map is mapped like Log Map (with the mapped value of the function at its final
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iteration applied to the color palette) and produces 3D-like effects with orbit-trap renderings.

Outside Coloring Options

Iteration
The Iteration option uses the point's escape time.

Escape-time coloring.

Log Palette
A point is colored based on its logarithmic escape.  The QFactor controls the smoothness of
the coloring.  A small number from 10-20 works best here..

Log coloring.

Continuous Potential
A point is colored based on its continuous potential (when it blows up.)  The QFactor controls
the smoothness of the coloring.  A higher number from 2000-20000 works best here.

Continuous-Potential coloring.

Angle uses the absolute value of a point's exit angle (theta.)  This is the atan method in
Fractint.  Angle-Iteration uses the angle formed by the difference between a point's last two
exit values and subtracts the point's escape time.  This is Paul Carlson's atan method.

Set Only
The Set Only flag plots all outside points in the background color.
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8.1.1 Log Map

     Log Map produces colored bands on the inside of the complex set.  Points are mapped
according to what the value of z is at final iteration.

8.1.2 Small Log

     Small Log produces circular patterns inside the complex set.  Points are mapped according
to the smallest value z gets during iteration.

8.1.3 Indexed Log

     Indexed Log is mapped according to the escape time it takes z to reach its smallest value.

8.1.4 Linear Map

     Linear Map is mapped like Log Map (with the mapped value of the function at its final
iteration applied to the color palette) and produces 3D-like effects with orbit-trap renderings.

8.1.5 Indexed Linear

     Indexed Log is mapped according to the escape time it takes z to reach its smallest value.

8.1.6 Bubble

Bubble uses Paul Carlson's contour-mapping method to produce 3D-like bubble pictures.  The
method is very sensitive to which formula is used, working best with the basic Mandelbrot set
z^2+c and the like.   The Scaling variable (Fractal Parameters window)  needs to be a small
negative value, usually less than one.  A larger than necessary Scaling value will cause the
colors to overlap in the bubbles.  For split palette pictures, the colors are divided according to
their level index, as in Indexed Linear.   Note: the magnitude of the Scaling variable needs to
be increased or decreased proportionately by the number of palette splits to keep the
"bubbles" the same size.    The color ranges in the palette should be graded from light to dark
to highlight the bubble centers.

8.1.7 Use Level

     Use Level -- All points (inside and outside) are colored according to the Level curve
selected or Potential Linear if no level curve is selected.

8.1.8 Iteration

     Iteration option uses the point's escape time to color points outside the Mandelbrot or
Julia set.

8.1.9 Log Palette

     Log Palette -- A point is colored based on its logarithmic escape.  The QFactor controls
the smoothness of the coloring.  A small number from 10-20 works best here..
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8.1.10 Continuous Potential

     Continuous Potential -- A point is colored based on its continuous potential (when it
blows up.)  The QFactor controls the smoothness of the coloring.  A higher number from
2000-20000 works best here.

8.1.11 Angle

     Angle uses the absolute value of a point's exit angle (theta.)  This is the atan method in
Fractint.

8.1.12 Angle-Iteration

     Angle-Iteration uses the angle formed by the difference between a point's last two exit
values and subtracts the point's escape time. This is Paul Carlson's atan method.

8.1.13 QFactor

     QFactor

The QFactor controls the smoothness of the coloring.  A small number from 10-20 works best
for Log Palettes, while higher number 2000-20000 is best for Continuous Potential.

8.1.14 Bubble Extensions

     The Bubble Extensions button selects the Bubble map and Use Level coloring methods,
and sets the Cutoff variable to a small negative value.  It also selects a Divide-by-two palette
if a split palette has not already been chosen.  (The Palette may need to be redesigned in the
Palette editor to match the split factor.)  This automates the process of producing Paul
Carlson's 3-D bubble-like fractals.

8.1.15 Biomorphic

    Biomorphic

Biomorphs test the real Z and imaginary Z values after exiting the iteration loop.  If the
absolute value of either is less than the preset zlimit, the point is mapped as part of the set.
This method produces biological-like structures in the complex plane.  Normally the
biomorph tendrils are colored in the set color (the color reserved for non-divergent or inner
points.)  With the Set Only flag on, the tendrils are colored according to the color-scaling
option used (other external points are colored in the background color.)

8.1.16 Decomposition

    Decomposition

When a Decomposition option is set, you have the option of performing either an external or
internal binary decomposition.  For Mandelbrot/Julia curves, z-arg is broken into two parts.

(Consult The Beauty of Fractals by Peitgen & Richter for a mathematical explanation of
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decomposition.)  When Biomorph or Epsilon is decomposed, the tendrils or hairs are
decomposed as external points.  Use the Set Only flag to emphasize the tendrils and hairs
when external decomposition is used.)

8.1.17 Set Only

     Set Only plots all outside points in the background color.

8.2 Orbit Trap Options

    Orbit Trap Options

This includes methods that trap the orbit of a point if it comes in range of a pre-specified area
or areas.

Enter a value for Epsilon and Epsilon2, which are used to define the size of the orbit trap
areas (.001-2.0 and 0.0-epsilon.)  The exclude box is used to exclude the first # iterations (0-
99) from orbit trapping.

Click on Apply to apply changes without closing the window.  Click on Okay to close the
window and apply changes, if any.  Click on Cancel to exit the window without changing
parameters.

Epsilon2 is used to create windows into the stalks.  The default value is 0.0, which produces
solid stalks.  Epsilon2 has no effect on the Petal method.

8.3 Use Pic as Trap Color

Use Pic as Trap Color

This option allows you to use a separate bitmap or picture to color the areas hit by the orbit
trap.  Enabled when a bitmap has been copied to the clipboard, each pixel inside the trap zone
is replaced with its corresponding color in the clipboard image.  This produces various
mirror-like effects with different orbit traps.  Notes: When you first enable this option,
whatever is in the clipboard gets copied to a buffer file for use as the picture trap.  To change
the picture in the buffer, you need to disable this option, and then re-enable it.  The clipboard
image isn't saved with the data file, so you need to remember which bitmap file is used for the
"pic trap", to redo a fractal like this later.  For larger file sizes it helps to use higher-resolution
clipboard images to reduce graininess in the target image.  It also helps to move details
around in the clipboard image, as the orbit traps tend to make non-symmetrical use of the pic-
trap image.

8.4 Process Bailout

Process Bailout command
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For 3-D Julia fractals, the figure shape is defined by the dynamics of the orbit-trap,
biomorphic or bubble method used.  This has no affect on the figure if none of these methods
are used for rendering.  With orbit-traps and bubble fractals, this has the effect of blanking
out all portions of the image that are not "trapped" or bubbles.  With different mapping, the
bubble and biomorphic options can add extra details (like stalks) outside of the actual 3-D
figure, when the Set Only flag is not selected, instead of a plain background.

8.5 Divide by One Palette command

  Divide by One Palette

Palette is not split before applying to pixel.

8.6 Divide by 2 Palette command

  Divide by Two Palette

Palette is split into two parts before applying to pixel.

8.7 Divide by 4 Palette command

  Divide by Four Palette

Palette is split into four parts before applying to pixel.

8.8 Divide by 8 Palette command

  Divide by Eight Palette

Palette is split into eight parts before applying to pixel.

8.9 Divide by 16 Palette command

  Divide by Sixteen Palette

Palette is split into sixteen parts before applying to pixel.

8.10 Divide by 32 Palette command

Divide by Thirty-Two Palette

Palette is split into thrity-two parts before applying to pixel.
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8.11 Texture Scale command

    Texture Scale

Opens a window to edit the 3-D texture scale factor.  The higher the scale factor, the more
repetitive the texture becomes.  Click on Apply to apply changes without closing the window.
Click on Okay to close the window and apply changes.  Click on Cancel to close the window
without applying changes.

8.12 Add Noise command

    Add Noise (Render menu)

Add noise to image texture.  A variation of Perlin's noise algorithm is used to add randomness
to an image's coloring.  Can be used with both 2-D and 3-D maps.

8.13 Factors command

    Factors (Render menu)

Edit noise factors.  The Blend variable determines how much noise is added to an image.  The
higher the blend, the more pronounced the noise appears.  This also tends to darken an image,
which can be compensated for by decreasing Gamma.  The Grain variable determines the
frequency of the noise.  The higher the grain, the noisier the image appears.  You can adjust
how the noise maps to an image by changing the scale factors.  Higher scale factors make the
image noisier on the respective axis (x, y and z.)  Additional variables affect the type and
shaping of the noise data: Gaussian is an alternate form of noise, while Planet, Check, Tooth,
Barber and Wood apply a specific envelope to the noise.  The Marble variable is used to
introduce a low frequency or high frequency modulation on top of the noise.  You can achieve
marble-like textures by combining a high frequency marble value with a low frequency Blend
value.  The marble variable also adds a high-frequency bump map to the wood envelope.

The Surface Warp variable allows you to apply the same noise to a 3-D Julia figure's shape
also, like a surface filter.  Small values are best for creating realistic surface variations, like
stone and wood grain.

8.14 Reset Noise Seed

    Reset Noise Seed (Render menu)

The random noise generator is re-seeded.  Use this to create variations on the noise texture.

8.15 Filter command

    Filter (Render menu)

Based on Stephen C. Ferguson's filter algorithms in his program Iterations, this option allows
you to choose one of 26 tail-end filters for surface rendering.  Corresponds roughly to its
effect on the basic Mandelbrot-squared set.  The effect will vary with the formula and fractal
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type chosen.

The Magnify variable is used to intensify or de-intensify the effect of the filter.  This value
can range from 1-500 nominally. Click on Apply to apply a new filter without closing the
window.  Click on Okay to close the window and apply changes.  Click on Cancel to close the
window without applying changes.

9 Pixel Menu

  Pixel menu commands

The Pixel menu offers the following commands:

Phoenix Phoenix orientation.
Invert  Invert image around circle.
Invert Off  Reset inversion flag.
Torus  Use torus method.
Torus Off  Reset torus flag.
Symmetry->  Horizontal, vertical or XY symmetry.
Switch Z For C  Switch z for c.
Solid-Guessing  Solid-guessing plotting mode.

9.1 Phoenix option

    Phoenix option (Pixel menu)

The Phoenix flag rotates the planes, so that the imaginary plane is mapped horizontally and
the real plane is mapped vertically.

9.2 Invert command

    Invert (Pixel menu)

The Invert flag inverts the plane around a circle. A window is opened that allows the user to
specify the circle's radius and center coordinates.  Select Auto Coords to let Orca calculate the
center coordinates and circle radius.  Using Auto Coords, the new radius and center
coordinates are calculated when the picture is next drawn.  You can zoom on an inverted
picture as long as radius and center coordinates remain the same.  Use the Perspective box to
alter the X/Y symmetry of the inversion.  A smaller Perspective value (less than 1.0) stretches
the inversion in the vertical direction.
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Original picture

Inverted

9.3 Invert Off  command

    Invert Off (Pixel menu)

Turns off the inversion flag.  Alternatively you can set the inversion radius to 0.0 to turn off
inversion.

9.4 Torus command

    Torus Command
Pixels are mapped around a torus, and then expanded to fit the drawing area.  A generalized
form of Earl Hinrichs' torus method, variables are provided for center x and center y to define
the c and z radii and may both equal 0.0.  Results will vary with the formula used, but
resembles the warping effect found in hypercomplex images.  Two versions of this method
are provided:  the Pixel method which uses pixel values to map the torus to the fractal space,
and the Two-Pi method which uses an initial rectangle 2 pi by 2 pi to map the torus to a
fractal image.  With the Two-Pi method, when you zoom the rectangle's size and starting
points are changed to match the zooming area.  The rectangle's coordinates are saved with the
fractal.  If you turn off the torus flag after zooming and then reinitialize the torus flag, the
rectangle reverts to a 2X2 area, so the image will change accordingly.  Rotating is not
supported for the Two-Pi method, but does work in a limited way with the Pixel method.

9.5 Torus Off

    Torus Off

Turns off the torus flag.  Alternatively you can enter a negative value to turn off this flag.
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9.6 Symmetry ->

    Symmetry (Pixel menu)

This produces a mirror image from left to right (vertical) or top to bottom (horizontal) or both
(xy).  You can zoom with symmetry, but the results will be uncertain if the zoom box is off-
center on the window.

Vertical symmetry

Horizontal symmetry

XY symmetry

9.7 Switch command

    Switch Z For C

When a Switch flag is set, you have switch Z for C.  When Z is switched for C, normally you
get Mandelbrots from Julia sets and vice versa.

9.8 Solid Guessing

    Solid Guessing (Pixel menu)

In the solid-guessing plotting mode, the program guesses at colors that lie inside rectangular
areas of the plot.  It first computes all the perimeter pixels of a rectangle, and checks if all the
pixels have the same color.  If so, all the pixels inside the rectangle are colored the same and
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no further calculations are done on that rectangle.  Otherwise the rectangle is broken into four
parts and the above procedure is repeated for each part.  If any of the perimeter pixels are
different at this point, all the remaining pixels in the smaller rectangle are computed.  The
screen is updated in groups of 16 lines.

Note: this mode is disabled if the drawing aspect is other than 4/3 or 1/1.

10 View Menu

  View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar      Shows or hides the status bar. 

10.1 Toolbar command

  Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the
most common commands in Orca, such as File Open.  A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.

10.1.1 toolbar

  Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.  The
toolbar provides quick mouse access to many tools used in Orca,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open the Orca Remote which contains shortcut buttons for many common tasks
and options in Orca

Use Pilot to rotate figure, zoom and alter key cubic variables.

Open a new drawing, based on the default template.

Open an existing drawing.  Orca displays the Open dialog box, in which you can
locate and open the desired file.

Save the active drawing or template with a new name.  Orca displays the Save As
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dialog box.

Set image size.

Edit formula/type data.

Edit fractal parameters.

Edit ray-tracing variables.

Edit palette.

Draw image from current parameters.

Continue drawing.

Zoom into rectangle.

Show picture full-screen.

Reset coordinates.

Draw Mandelbrot set

Draw Julia set

Display info about Orca.

Display Orca's help index.

10.2 Status Bar Command

 Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be
executed by the selected menu item or depressed toolbar button, and keyboard latch state. A
check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.

10.2.1 status bar

 Status Bar

The status bar is displayed at the bottom of the Orca window.  To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus.  This area similarly shows messages that describe the actions of
toolbar buttons as you depress them, before releasing them.  If after viewing the description of
the toolbar button command you wish not to execute the command, then release the mouse
button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
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SCRL The Scroll Lock key is latched down.

11 Window Menu

  Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple
images in the application window:

Cascade   Arranges windows in an overlapped fashion.
Tile     Arranges windows in non-overlapped tiles.
Arrange Icons     Arranges icons of closed windows.
Size Desktop     Size drawing area to window frame.
Window 1, 2, ... Goes to specified window.

11.1 Cascade command

Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.

11.2 Tile command

Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.

11.3 Arrange Icons command

Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main
window.  If there is an open drawing window at the bottom of the main window, then some or
all of the icons may not be visible because they will be underneath this drawing window.

11.4 Size Desktop command

Window Size DeskTop Command

Use this command to size the active drawing window to its frame size.  Use after Tile
command to reduce white space around a drawing that is smaller than screen size.
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11.5 1, 2, ... command

1, 2, ... command (Window menu)

Orca displays a list of currently open drawing windows at the bottom of the Window menu.
A check mark appears in front of the drawing name of the active window.  Choose a drawing
from this list to make its window active.

12 Video Menu

  Video menu commands

The Audio/Video menu offers the following commands:

Write Avi Video Write video buffer to file.
Add Key Frame Add image to video buffer.
Reset Frames  Reset frame buffer.
Edit Frames  Edit frames in frame buffer.
Load Frames [OCV] Load frame buffer.
Save Frames [OCV] Save frame buffer.

View AVI  View an AVI animation file.

12.1 Write Avi Video

    Write Avi Video

Through a series of windows, this allows you to name and open an avi animation stream and
choose a compression method.  After using the file requester to name the file, you are given a
choice of compression methods.  The compression methods include Intel Indeo Video®,
Microsoft Video 1 and Cinepak Codec by Radius.  (All compression methods degrade the
original images, some more than others.)  The frames defined by the frame buffer are then
plotted and written to the avi stream and the stream closed.  Variables between each key
frame are interpolated and frames added to the avi file to give the illusion of animation.

12.2 Add Key Frame

  Add Key Frame

Orca uses a frame buffer to compose an animation.  You add key frames to the buffer with
this command.  Each key frame is identical to the active image.  Change  variables between
key frames to create the illusion of motion or morphing.  You can edit the frames with the
frame editor.
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12.3 Reset Frames

   Reset Frames

Delete the current frame buffer.  The number of video frames is reset to zero.

12.4 Edit Frames

    Edit Frames

When the frame editor window is open you can edit the frames in the video buffer by using any of the
other editor windows.  The Move button allows you to move a frame from one spot in the buffer to
another.  You can change the frame image being edited by using the Frame slider or Edit box.  After
changing frames, use the Preview button to display the current frame being edited.  The Delete button
allows you to delete all but two of the frames, the minimum number of frames to create a movie.  (If
you want to delete all the frames, use the Video/Reset Frames command.) The Spread variable
determines how many frames are generated between key frames.  A higher value produces a
smoother video, but also adds to the file size.

12.5 Save Frames [OCV]

This command saves the current frame buffer in a [ocv] file.  A file requester is opened that allows
you to choose the location and name of the frame library.  The frame buffer files can also be used as
image libraries, similar to Fractint's par and frm formats.  The frames contain all the information to
reproduce an image at any supported size.

12.6 Load Frames [OCV]

Load a frame buffer that has been previously saved by Orca.  The buffer replaces any existing frame
buffer.

12.7 View Avi command

    View Avi…  (Video menu)

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file
name.  A multimedia box will appear to the right of the file list.  Click on okay to open the
main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto
rewind/repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing
speed.  A click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file.  Use the Save button to save the file in a
different compression format.  You must use a different name to save the file than the name
that was used to open it.  Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimedia file, including midi files.
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12.8 Avi Composite option

    AVI Composite (Video menu)

When this flag is set, Orca generates composite frames for a video according to the settings in
the Image/Composite window.  Each frame may then consist of a merging of up to 4 figures
(1-4).  You must set this flag and the composite options before beginning a video.  After an
avi stream has been opened, you can then use variations of any figure in the composite to
produce tweens while using the Write Frames option.  As usual, you vary data in the figure(s)
before writing frames.

13 Demo Menu

  Demo menu commands

The Demo menu offers the following commands, which illustrate various features of Orca:

Random 2-D Julia Generate random 2-D Julia set fractal.
Random Stalks Generate random orbit-trap Julia set fractal.
Random Bubbles Generate random bubble Julia set fractal
Random 3-D Julia Generate random 3-D Julia set fractal.
Random Render Apply random coloring.
Batch Mode/Random Setup Set up initial values for batch mode/random commands.

13.1 Random 2-D Julia

    Random 2-D Julia (Demo menu)

A random Julia fractal is generated.  Many of the built-in options of Orca are selected on a
random basis (if enabled in the Random Setup window), and the Mandelbrot space for one of
the twenty-two built-in formulas is scanned for an interesting Julia set.  The palette used is
also randomized (if Random coloring is selected.).  Note:  In most cases the Julia search is a
short one, but sometimes the "seek" mode can seem to get stuck when the criteria for an
interesting Julia set fails to match the formula used.  In the latter case, click the left mouse
button to restart the search process.  Tip: some things remain to be done after the Julia set is
drawn.  Feel free to experiment with all the parameters, reframe the image, change palettes
etc.  This routine provides a fast intro to many options in Orca that the user may be unfamiliar
with: no knowledge of fractal science/math required!  See the hot keys section also for a
description of the 'F' command.

13.2 Random Stalks

    Random Stalks (Demo menu)

A random Julia fractal is generated using one of Paul Carlson's orbit trap methods.
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13.3 Random Bubbles

Random Bubbles (Demo menu)

A random Julia fractal is generated using Paul Carlson's bubble method.

13.4 Random 3-D Julia command

    Random 3-D Julia (Demo menu)

A random quaternion/hypernion fractal is generated.  A set of formulas appropriate for 3-D
fractals is scanned to find an interesting Julia set, and then the parameters are adjusted to
produce a quaternion or hypernion image.  The ranges are reset (if z-space is unselected in the
Random Setup window), Z is set to 2.0, and the lighting is set for optimum viewing (if
lighting is checked in the Random Batch window.)

Note: for some images a Z value of 2.0 may result in a partially clipped image.  Sometimes it
helps to increase this value to 2.5 or 3.0, but too high a value may interfere with solid
guessing.

See the hot keys section also for a description of the 'G' command.

13.5 Random Render command

    Random Render (Demo menu)

A random coloring filter is applied.  This changes the surface textures of the 3-D figure.

13.6 Batch Mode / Random Setup

    Batch mode/Random Setup (Demo menu)

Here you set parameters for batching and saving random-generated images to disk.  You can
also customize random variables to direct how the random scanning process works.  When
the Repetitions value is non-zero, up to 1000 random images can be generated and saved to
disk.  Use a unique Filename to prevent batch files from overwriting existing image files.
You can also change the default directory for batch files, by clicking on the "…" button next
to the default directory box.  The Scan Limit directs the program on how many scans it makes
through each formula before it skips to a new formula (if an interesting fractal space hasn't
been found.)

There are radio boxes that allow you to customize how random variables are processed to
create new fractals:

Formula  -- (default on) check to randomize built-in formula used
Lighting  -- (default off) check to set default lighting
Symmetry -- (default off) check to randomize symmetry used
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Rotation -- (default on) check to randomize camera angles
Coloring -- (default off) check to reset coloring parameters
Iteration -- (default off) check to randomize iterations
Z-Space -- (default on) check to set default z-space
Constants  -- (default on) check to randomize the complex constants cj and ck
Slices -- (default off) check to randomize slice in Initial Values window
Stalks -- (default off) check to randomize orbit-trap
Level -- (default off) check to randomize level curve
Filter -- (default off) check to randomize filter
Fn1/Fn2 -- (default off) check to randomize user-defined functions
Types -- (default on) check to randomize quad math used
Mapping (default off) check to randomize bailout mapping

The Bounds variable (default 0) acts to delimit the boundary scan after finding a random Julia
set.  Since the scanning process is closely connected with the Mandelbrot set boundaries,
most 3-D fractals found this way are very connected/closed figures.  The bounds variable adds
a random distance from the Mandelbrot boundary to produce more open fractals.  A good
value to start with is 25 if you want to experiment with this option.

14 Help Menu

  Help menu commands

The Help menu offers the following commands, which provide you assistance with this
application:

Getting Started     Tutorial for new users of Orca.
Index      Offers you an index to topics on which you can get help.
Hot Keys      Quick reference to Orca's hot keys.
Parser Info      Quick reference to Orca's parser variables and functions.
Built-in Formulas     Quick reference to Orca's built-in formulas.
Bibliography      Sources for fractal information and complex numbers.
About Orca      Displays the version number and author info for this application.

14.1 Getting Started

    Getting Started

Welcome to Orca!
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This is a short tutorial that will cover basic commands and background material necessary for
a new user to create an initial picture with Orca.  For help on any menu command, press F1
while the command is highlighted.  For help with a dialog window, click on the Help button
inside that window.

Start by resetting all Figures, using the Image/Reset All menu option.  The drawing window is
erased and a quaternion map of the Mandelbrot set is drawn.  The 2-D Mandelbrot set is
frequently considered a map of all Julia sets.  Here we are just interested in what 3-D Julia
sets can be generated using the 3-D Mandelbrot as a rough map.  Use the
hot key combo shift-G to turn on 3-D exploratory mode.  The cursor changes and you can
click on any portion of the draw window.  If you left-click inside the draw window, the right-
hand corner (in this case called sector 2) will be erased, and a miniature version of the Julia
set that uses that space as its constants will be drawn.  You can continue to click on areas of
the draw window and see what Julia set lies there, or you can press the space bar to open a
new window and draw the quaternion full-size.  Press 'Esc' to exit this mode without creating
a new window.

Once you've found and drawn a Julia set that looks good, you can change its palette or surface
pattern.  Use the palette editor to create a custom palette, or even create a random palette
using the Random button.

For a good preview of what Orca is capable of, be sure to experiment with all the
Demo/Random commands.

You'll probably be doing a lot of zooming and framing on your plots later, so we'll cover that
briefly here.  After the fractal is finished plotting (or as much of it is finished that you want to
zoom in on), select the Zoom command off the Image menu, or just point and click the left-
mouse button over any area of the drawing.  A box a quarter the size of the window will
appear that you can move around with the mouse.  Hold the left-mouse button down to shrink
the box, or the right-mouse button down to expand the box.  Move the box over the area you
are zooming in on, size the box if necessary and when it includes the details you want, press
the space bar.  The plot will be redrawn at zoom scale.  To zoom out, you can use the Shift
key to expand the zoom box X 4.  To exit this mode without zooming, click on the title bar of
the draw window or press 'Esc'.  Most of the time you'll be zooming in to reframe a fractal, or
zooming out to include parts of the fractal that may appear outside the default z-space.

Special note: As you explore the many options included in Orca you'll find that many of the
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variable windows are non-modal, so they can stay open while the fractal is being plotted.
This allows you to change some coloring and lighting variables without redrawing the fractal,
or repeatedly experiment with other aspects of the fractal-design process.  All of the non-
modal windows have an Apply button for applying changes directly without closing the
window, or an Okay button for applying changes and closing the window.  To close the
window without making any further changes, click on the window's close button.  The Cancel
button, if present, allows you to revert to when the window was last opened.  Some
commands external to the window may cause it to close and reopen if variables were changed
externally.  In this case Cancel "goes back" to after the window was reopened.

Orca allows you to Undo the last command in most cases.  However this is mostly a failsafe
command, as it requires you to redraw the fractal to change colors or lighting variables.

This completes the Getting Started tutorial.  Be sure to read the hot keys and built-in formulas
sections for additional info.  The Bibliography lists additional reference material for a better
understanding of the fractal types and functions contained in Orca.

14.2 Index command

Index command (Help menu)

Use this command to display the opening screen of Help.  From the opening screen, you can
jump to step-by-step instructions for using Orca and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the
opening screen.

14.3 Hot Keys

    Hot keys

Shift-P --- grab point from Mandelbrot set(real and imaginary parts) and put values in
complex constant.  Cursor changes to a cross-hatch, which you position over the area of the
Mandelbrot set of interest.  Then click the left-mouse button to transfer the pixel's coordinates
to the c constant.  Click outside window or in window frame to exit routine without
"grabbing" a point.

Shift-J -- like "P", except that a Julia set is drawn immediately in sector 2 at size 100 and with
iterations of 100.  This is a fast exploratory routine for finding interesting Julia sets that can
also be used where the Mandelbrot set is discontinuous as in the Phoenix formula.  Unlike the
"P" command, "grabbing,"(and drawing) continues until you click on the window's frame.
Note: when you exit the J command, once you find an interesting Julia set; another window is
opened with the Julia type set.  The parameters in the original window revert to their original
Mandelbrot settings. Click on the escape key to exit this mode without generating a Julia set.

Shift-G -- A 3-D Julia set is generated in sector 2, using an iteration count of 10 and other
parameters are changed temporarily to suit 3-D plots.  (Z is set to 2.0, the rotational variables
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are reset and the light source is set to the default, if random lighting is enabled.)    Once you
find an interesting quaternion set using "G" (by clicking in any area around the Mandelbrot
borders or anywhere in the draw window), press the space bar and another window is opened
that sets the fractal parameters to those in the exploratory window.  The parameters in the
exploratory window revert to their original settings.  Click on the escape key to exit this mode
without generating a Julia set.

Shift-U -- like "G" except that you choose the target type and beginning parameters.  This is
useful for exploring cubic Mandelbrot sets, insofar as you can scan the complex c planes for
interesting variations.  Also works for other multi-dimensional Mandelbrot formulas that are
dependent on the c planes.  Hint:  turn off the Image/Auto-Redraw option after drawing the
mapping picture.  You can then set the target set (Mandelbrot, quaternion, etc.) before using
this key sequence, without erasing the mapping picture.

Shift L: -- Like 'G' except this modifies the ci and cj elements of the complex constant to
locate a quaternion Julia set.

Shift K: -- Like 'G' except this modifies the cj and ck elements of the complex constant to
locate a quaternion Julia set.

Shift-F -- generate a Julia set from a formula's MandelbrotP space.  Random points in a
formula's current Mandelbrot space are scanned for an interesting Julia set.

Shift-Z -- zoom in/out coordinates.  Like the menu command except does not immediately
redraw the picture.  This allows you to zoom into another screen sector without erasing the
previous picture.

Shift-C -- clear the draw window to the current background color.

14.4 Parser Information

    Parser Information (for optional Bail box)

Functions (capital letters are optional, and parenthesis are necessary around complex
expressions)

The following information takes the form "standard function" ---"form used by Orca to
represent standard function".

sine z --- sin(z) or SIN(Z)     ; where Z can be any quad expression or variable
hyperbolic sine z --- sinh(z) or SINH(Z)
arcsine z --- asin(z) or ASIN(Z)
cosine z --- cos(z) or COS(Z)
hyperbolic cosine z --- cosh(z) or COSH(Z)
arccosine z --- acos(z) or ACOS(Z)
tangent z --- tan(z) or TAN(Z)
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hyperbolic tangent z --- tanh(z) or TANH(Z)
arctangent z --- atan(z_) or ATAN(Z)
cotangent z --- cotan(z) or COTAN(Z)
arccotangent z --- acotan(z) or ACOTAN(Z)
e^z --- exp(z) or EXP(z)  -- the exponential function
natural log of z --- log(z) or LOG(Z)
absolute value of z --- abs(z) or ABS(Z)
square root of z --- sqrt(z) or SQRT(Z)
z squared --- sqr(z) or SQR(Z)
real part of z --- real(z) or REAL(Z)
imaginary part of z --- imag(z) or IMAG(Z)
'j' or third component of z ---  imaj(z) or IMAJ(Z)
'k' or fourth component of z ---  imak(z) or IMAK(Z)
convert z-real to zi -- gami(z) or GAMI(Z)
convert z-real to zj -- jami(z) or JAMI(Z)
convert z-real to zk -- kami(z) or KAMI(Z)
modulus of z --- mod(z) or MOD(Z) or |z|   -- (x*x + y*y)
conjugate of z -- conj(z) or CONJ(z) -- (x-yi)
flip(z) --- flip(z) or FLIP(Z)    -- exchange real and imaginary parts of z (y+xi)
polar angle of z -- theta(z)

Math operators

+ ---  addition
- ---  subtraction
* ---  multiplication
/ ---  division
^ ---  power function
< ---  less than
<= --- less than or equal to
> --- greater than
>= ---  greater than or equal to
!= --- not equal to
== --- equal to
|| --- logical or (if arg1 is TRUE(1) or arg2 is TRUE)
&& --- logical and (if arg1 is TRUE and arg2 is TRUE)

Constants and variables

complex constant --- c or C, read/write.
complex conjugate --- cc or CC, read-only.
e  --- e or E  -- 1e^1 -- 2.71828, read/write.
i  --- i or I  -- square root of -1, read-only.  This is equivalent to the quad constant 0+1i+0j+0k.
iteration --- iter -- iteration loop counter
j --- j or J -- third component of quad constant, read-only. This is equivalent to the quad
constant 0+0i+1j+0k.
k --- k or K  -- fourth component of quad constant, read-only.  This is equivalent to the quad
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constant 0+0i+0j+1k.
p --- p or P  -- the real part of the complex constant, as entered in the cr box, read-only.
p1 – the quad constant entered in the cr, ci, cj and ck boxes, read-only.
pi --- pi or PI -- 3.14159, read/write.
q --- q or Q  -- the imaginary part of the complex constant, [ci box] evaluated as a real
number, read-only.
x --- x or X  -- real part of Z, read/write.
y --- y or Y  -- coefficient of the imaginary part of Z, read/write.
z --- z or Z  -- function value at any stage of the iteration process, read/write.
zn or ZN -- the value of z at the previous stage of iteration, read-only.

14.5 Built-in Formulas

    Built-in Formulas (enter or select the following prefix in the Function dropdown box)

A0 fn1(z)*fn2(z)+c  (Note 1)
A1 fn1(z)-cfn2(z)

    A2 fn1(z)+fn2(z)+c
    A3 cfn1(z)*fn2(z)+c
    A4 fn1(z)+cfn1(z)+1"
    A5 fn1(fn2(z))+c"
    A6 fn1(z)+fn2(c) "
    A7 fn1(z)+fn2(zn)+c"
    A8 cfn1(z)+fn2(zn)"
    A9 fn1(z)+k*fn2(zn)+j"
    B0 fn1(z)/fn2(z)+c"
    B1 fn1(z)*(1/(fn2(z)+c))"

B2 (fn1(z)/fn2(z))^2+c"
B3 (fn1(z)/fn2(z))^3+c"
B4 fn1(z)/(1-fn2(z))+c"
B5 fn1(z)*fn2(z)-c (var)"
B6 fn1(z)/(fn2(z)+c)"
B7 cfn1(z)*(1-fn2(z))"
B8 if(abs(z)>S fn1(z) else fn2(z))+c"  (Note 2)
B9 fn1(z)*(1-c*fn2(z))+c"
C0 fn2(fn1(z)+c1)+c2" (Note 3)
C1 fn1(z)-3*c1^2*fn2(z)+c2"

Note 1:  fn1 and fn2 are functions selected from the fn1 and fn2 boxes in the
Formula Parameters window:
0: sin(w). 1: sinh(w). 2: cos(w). 3: cosh(w).
4: tan(w). 5: tanh(w). 6: exp(w). 7: ln(w).
8: w^c 9: w^z. 10: 1/w. 11: w^2. 12: w^3.
13: abs(w). 14: sqrt(w). 15: w. 16: conj(w).
17: csc(w). 18: csch(w). 19: sec(w). 20: sech(w).
21: cot(w). 22: coth(w). 23: cw. 24:
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1.
25: arsin(w). 26: arcsinh(w). 27: arccos(w). 28:
arccosh(w).
29: arctan(w). 30: arctanh(w). 31: arccot(w). 32:
arccoth(w).
33: vers(w). 34: covers(w). 35: L3(w): 3rd degree Laguerre
polynomial.
36: gamma(w): first order gamma function. 37: G(w): Gaussian probability function -
- (1/sqr(2pi))*e^(.5w^2).
38: c^(s+si). 39: zero. 40: w^(s+si). 41:
|(wx)|+|(wy)|*i(abs).
42: wy+wx*i(flip). 43: conj(cos(w))--cosxx. 44: theta(w) -- polar angle(w).
45: real(w). 46: imag(w) 47: w+c 48: w^2-c
49: w^3-c 50: pi*w 51: e*w

Note 2: S is entered in the S box in the Formula Parameters window.

Note 3: Part of c2(real) and the rest of c2(c2i, c2j and c2k) are entered as the Complex
constant in the Fractal Parameters window.  C1 is defined as initial z (z-real and z-imag) and
is handled independent of any user input.
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14.7 About Orca

    About Orca

>>>>> Orca™  v3.057 © 2008 by Terry W. Gintz

Orca graphs 2-D and 3-D slices of formulas based on 4-D complex number planes.  Orca
currently supports quaternion, hypernion, cquat and juliat renderings of the Mandelbrot set
and Julia sets.  The complex math functions supported include sin(z), sinh(z), z^z, e^z, z^n,
sqrt(z), cos(z), cosh(z), tan(z), tanh(z), log(z), ln(z), n^z and others.  Random image
generators, batch mode and integrated video routines make the program easy for beginners
and a powerful complement to advanced fractal artists.

Hypercomplex extensions (as described in Fractal Creations) are standard for all the formulas.

Orca requires a true-color video adapter for best results.  It works in 16-bit (high color) also.

Memory requirements for Orca vary with the size of the drawing area Orca opens on, ranging
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from approximately 3 megabytes memory for a 640X480 area to 48 megabytes for a
2048X1536 area.  Special routines have been added to reduce memory requirements for large
bitmaps (up to 14400X10800) by writing these directly to a file instead of using a memory
bitmap.

Acknowledgements:  many thanks to Paul Carlson for his algorithms for 3D-like fractals.
Special thanks to Frode Gill for his quaternion and ray-tracing algorithms, to Dirk Meyer for
his Phong-shading algorithm, and to David Makin for sharing his ideas on quaternion
colorings and 3-D insights. Thanks also to Francois Guibert for his Perlin noise example. The
multi-windowing interface in Orca is courtesy of that extraordinary and prolific fractal
programmer, Steven C. Ferguson.

For a short history of the programs preceding Orca, see Chronology.

14.8 Chronology

   Chronology

History of this program:

In September 1989, I first had the idea for a fractal program that allowed plotting all complex
functions and formulas while attending a course on College Algebra at Lane College in
Eugene, Oregon.  In November 1989, ZPlot 1.0 was done.  This Amiga program supported up
to 32 colors, 640X400 resolution, and included about 30 built-in formulas and a simple
formula parser.

May 1990 -- ZPlot 1.3d -- added 3-D projections for all formulas in the form of height fields.

May 1991 -- ZPlot 2.0 -- first 236-color version of ZPlot for Windows 3.0.

May 1995 -- ZPlot 3.1 -- ZPlot for Windows 3.1 -- 60 built-in formulas.  Added hypercomplex
support for most built-in formulas.

May 1997 -- ZPlot 24.02 -- first true color version of ZPlot --  91 built-in formulas.  Included
support for 3-D quaternion plots, Fractint  par/frm files, Steve Ferguson's filters, anti-aliasing
and Paul Carlson's orbit-trap routines.

June 1997 -- ZPlot 24.03 -- added Earl Hinrichs Torus method.

July 1997 -- ZPlot 24.08 -- added HSV filtering.

December 1997 -- Fractal Elite 1.14  --  100 built-in formulas; added avi and midi support.

March 1998 --Split Fractal Elite into two programs, Dreamer and Medusa(multimedia.)

April 1998 -- Dofo 1.0 -- supports new Ferguson/Gintz plug-in spec.
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June 1998 -- Dofo-Zon -- redesigned multi-window interface by Steve Ferguson, and includes
Steve's 2-D coloring methods.

August 1998 --Dofo-Zon Elite -- combination of Fractal Elite and Dofo-Zon

October 1998 -- Dofo-Zon Elite v1.07 -- added orbital fractals and IFS slide show.

November 1998 -- Dofo-Zon Elite v1.08 -- added lsystems.

April 1999 -- Split Dofo-Zon Elite into two programs: Fractal Zplot using built-in formulas
and rendering methods, and Dofo-Zon to support only plug-in formulas and rendering
methods.

May 1999 -- Fractal Zplot 1.18 --  added Phong highlights, color-formula mapping and
random fractal methods.

June 1999 -- completed Fractal ViZion -- first version with automatic selection of
variables/options for all fractal types.

July 1999 -- Fractal Zplot 1.19 -- added cubic Mandelbrot support to quaternion option; first
pc fractal program to render true 3-D Mandelbrots.

September 2000 -- Fractal Zplot 1.22 -- added support for full-screen AVI video, and
extended quaternion design options

October 2000 -- QuaSZ(Quaternion System Z) 1.00 -- stand alone quaternion/hypernion/cubic
Mandelbrot generator

November 2000 -- Added octonion fractals to QuaSZ 1.01.

March 2001 -- Cubics 1.0 -- my first totally-3-D fractal generator.

May 2001 -- QuaSZ 1.03 -- added Perlin noise and improved texture mapping so texture
tracks with animations.

June 2001 -- Fractal Zplot 1.23 -- added Perlin noise and quat-trap method.

July 2001 -- QuaSZ 1.05 -- improved performance by converting many often-used dialogs to
non-modal type.
November 2001 -- DynaMaSZ 1.0, the world's first Dynamic Matrix Systems fractal generator

January 2002 -- MiSZle 1.1 -- generalized fractal generator with matrix algebra extensions

May 2002 -- DynaMaSZ  SE 1.04 (unreleased version)-- scientific edition of DMZ, includes
support for user-variable matrix dimensions (3X3 to 12X12)

January 2003 -- PodME 1.0 -- first stand-alone 3-D loxodromic generator, Hydra 1.0 -- first 3-
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D generator with user-defined quad types and Fractal Projector a Fractal ViZion-like version
of DMZ SE limited to 3X3 matrices

May 2003 -- QuaSZ 3.052 -- added genetic-style function type and increased built-in formulas
to 180.  Other additions since July 2001: generalized coloring, support for external coloring
and formula libraries, and Thomas Kroner's loxodromic functions.

May 2003 -- FraSZle and Fractal Zplot 3.052 -- added random 3-D orbital fractals, new 3-D
export methods, upgraded most frequently-used dialogs to non-modal type and added genetic-
style function type.  FZ now based on FraSZle except for built-in formula list and Newton
support.

July 2004 – Added the features of Hydra, Cubics and PodME to QuaSZ, now renamed "Quad
Surface Zplot".  Merged FraSZle with Fractal Zplot, and Fractal Projector with DynaMaSZ
SE to form DynaMaSZ 2, including support for the original DynaMaSZ files.
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